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WARNING

 

Use this product only in the manner described in this guide. When used 
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WARNING

 

    

Risk of electric shock! 

The HyperCyt® System contains voltages that are potentially hazardous. To 
reduce the risk of electric shock, do not remove covers without proper 
training. Periodically inspect power cords and plugs for proper condition and 
replace as necessary. 
ONLY QUALIFIED SERVICE PERSONNEL may perform testing or repairs.  





 

  
  

IntelliCyt Corporation Software License Agreement 
 
This Software License Agreement (“Agreement”) for the HyperCyt® software, including HyperCyt® Controller software and 
HyperView® Designer and Analysis software (collectively “Software”), is entered into in conjunction with the purchase of the 
license to the Software. By installing and using the Software, Licensee accepts the Software and agrees to be bound by the 
terms of this Agreement. 
 
1) License Grant: IntelliCyt Corporation ("Licensor"), grants the purchaser ("Licensee") a non-exclusive, non-transferable 
license (“License”) to use the Software, and associated manuals and documentation, in conjunction with hardware 
configurations authorized by IntelliCyt Corporation, at the designated Licensee's business location until this License is 
terminated in accordance with the terms and conditions specifically set out in the Agreement. This License permits the 
Licensee to make one copy of the Software in machine-readable form for backup purposes only. 
 
2) Licensor’s Rights: Licensor represents that it has all rights necessary to grant the license herein. The Software is 
protected by patents, patent applications, and copyrights and includes valuable trade secrets and other proprietary material. 
Licensee agrees to treat the Software as confidential and not to copy, reproduce, sub-license, or otherwise disclose the 
Software or its associated manuals and documentation to third parties, including any parent, subsidiaries, or affiliated entities, 
without the prior written consent of Licensor, and all Licensee personnel using the Software shall be so advised. Licensee 
agrees not to disassemble, decompose, reverse engineer, or otherwise translate the Software. Licensee agrees not to modify 
the Software, not to allow access to the Software through any terminal located outside of Licensee’s location, and that any 
derivative works and the backup copy are the sole property of the Licensor. 
 
3) Term: This License is effective at the time the Licensee receives the Software. Termination shall occur when Licensee 
ceases all use of the Software and returns or destroys all copies thereof. This License shall automatically terminate upon the 
failure of the Licensee to comply with any of the terms of this Agreement. Sections 2, 4, and 5 shall survive the termination of 
the License for any reason. 
 
4) LIMITATION OF LIABILITY: LICENSOR SHALL HAVE NO LIABILITY WITH RESPECT TO ITS OBLIGATIONS UNDER 
THIS AGREEMENT OR OTHERWISE FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES, 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER FOR BREACH OF CONTRACT, TORT 
(INCLUDING NEGLIGENCE) OR OTHERWISE, ARISING OUT OF OR RELATED TO THIS AGREEMENT, INCLUDING BUT 
NOT LIMITED TO LOSS OF ANTICIPATED PROFITS, LOSS OR INTERRUPTION OF USE OF OR CORRUPTION OF ANY 
FILES, DATA OR EQUIPMENT, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED 
REMEDY. THE PARTIES AGREE THAT THE FOREGOING LIMITATIONS REPRESENT A REASONABLE ALLOCATION OF 
RISK UNDER THIS AGREEMENT. 
 
5) DISCLAIMER OF WARRANTY: LICENSOR AND ITS DISTRIBUTORS MAKE NO PROMISES, REPRESENTATIONS OR 
WARRANTIES, EITHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE, WITH RESPECT TO THE SOFTWARE, 
MANUALS, AND DOCUMENTATION, INCLUDING THEIR CONDITION, THEIR CONFORMITY TO ANY REPRESENTATION 
OR DESCRIPTION, OR THE EXISTENCE OF ANY LATENT OR PATENT DEFECTS, AND LICENSOR AND ITS 
DISTRIBUTORS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT, 
AND FITNESS FOR A PARTICULAR PURPOSE.  LICENSEE ACKNOWLEDGES THAT THE LOADING OF THIS OR ANY 
THIRD PARTY SOFTWARE ON A COMPUTER SYSTEM MAY RESULT IN SYSTEM DAMAGE, DATA LOSS, DATA 
CORRUPTION OR SOFTWARE INCOMPATIBILITY. 
 
6) Miscellaneous: Licensee may not assign this Agreement or any rights or obligations hereunder, directly or indirectly, by 
operation of law or otherwise, without the prior written consent of Licensor. Subject to the foregoing, this Agreement shall inure 
to the benefit of and be binding upon the parties and their respective successors and permitted assigns. No waiver or 
modification of this Agreement shall be valid unless in writing signed by each party. The waiver of a breach of any term hereof 
shall in no way be construed as a waiver of any other term or breach hereof. If any provision of this Agreement is held to be 
unenforceable, such provision shall be reformed only to the extent necessary to make it enforceable. This Agreement shall be 
governed by United States and New Mexico law (except for conflict of laws principles).  United States law shall supplement 
New Mexico law where United States law is non-exclusive (e.g., trademark, trade secret, and unfair competition laws), and 
shall be exclusive where United States law is exclusive (e.g., copyright and patent laws). This Agreement contains the 
complete agreement between the parties with respect to the subject matter hereof, and supersedes all prior or 
contemporaneous agreements or understandings, whether oral or written.  The undersigned warrants that they have actual 
authority to bind Licensee as to the subject matter of the Agreement. 



 

 

 



 

DRAFT 11/6/2009 10:21:00 AM III 

         
 

 





 

  I  

Table of Contents 
In this Guide ............................................................................................................................... v 

Conventions .............................................................................................................................. vi 

Terminology ................................................................................................................................... vi 

Conventions ................................................................................................................................... vi 

Text Symbols ................................................................................................................................ vii 

Contacting Technical Support .................................................................................................. vii 

1 Safety Precautions and System Information ............................................................................ 1 

Safety Symbols .......................................................................................................................... 1 

General Precautions .................................................................................................................. 2 

HyperCyt® System Operation Precautions ................................................................................ 2 

HyperCyt Instrument ...................................................................................................................... 2 

HyperCyt® Computer ...................................................................................................................... 4 

System Components ...................................................................................................................... 4 

HyperCyt® System Information .................................................................................................. 5 

2 Setup of the HyperCyt® System ................................................................................................. 8 

System Overview ....................................................................................................................... 8 

HyperCyt® Instrument .................................................................................................................... 9 

HyperCyt Computer ...................................................................................................................... 10 

Software Applications .................................................................................................................. 10 

HyperCyt® Installation .............................................................................................................. 11 

Setting Up the HyperCyt System ................................................................................................ 11 

Sample Line Tubing Setup .......................................................................................................... 12 

Sample Probe Installation ........................................................................................................... 15 

Peristaltic Pump Setup ................................................................................................................ 16 

HyperCyt® System Shutdown .................................................................................................... 19 

3 Calibrating the HyperCyt® System ........................................................................................... 21 

Initial Autosampler Setup ......................................................................................................... 21 

Calibration of the HyperCyt® .................................................................................................... 22 

Deck Height Calibration ............................................................................................................... 24 

Calibration of Plate Coordinates ................................................................................................. 26 

Rinse Station Position Calibration ............................................................................................. 28 

Managing and Calibrating Plate Models .................................................................................. 29 

Adding a New Plate Model ........................................................................................................... 29 



 

II   

Calibrating the Well Depth for a New Plate Model .................................................................... 30 

View Calibration Summary ....................................................................................................... 32 

4 Design and Setup of an Experiment ........................................................................................ 34 

Creating a New Experiment in HyperView® Designer ............................................................. 34 

Experimental Setup ...................................................................................................................... 36 

Using HyperView® Designer Workspace to Define a Plate ....................................................... 37 

Sample Settings ............................................................................................................................ 38 

Contents ........................................................................................................................................ 42 

Designing Multiplate Experiments ............................................................................................ 47 

Importing Multiple Experiments……………………………………………………………………47 

5 Using the HyperCyt® Autosampler to Run a Plate ................................................................. 54 

Sampling an Experiment Using HyperCyt® Controller ............................................................. 54 

HyperCyt Controller Startup ........................................................................................................ 51 

Sampling a Multiplate Experiment Manual Control Mode ........................................................ 54 

Moving Around the Plate in Manual Control Mode ................................................................... 59 

HyperCyt Options ..................................................................................................................... 61 

6 Getting Started with HyperView® Analysis Software………………………………………….59 

Using HyperView® Analysis Software ...................................................................................... 63 

Creating a New Analysis .......................................................................................................... 60 

Well Identification ..................................................................................................................... 68 

Noise Gates (Debris filter) ........................................................................................................... 68 

Well Finder .................................................................................................................................... 70 

Improving Well Identification Results ........................................................................................ 75 

Exporting All Well FCS data ........................................................................................................ 76 

7 Populations in HyperView® Analysis ....................................................................................... 78 

Using the Data Display Grid and Minimap. .............................................................................. 78 

Populations .............................................................................................................................. 80 

Creating 2D Histograms ............................................................................................................... 81 

Working with Gates in 2D Histograms ....................................................................................... 83 

Creating and Using 1D Histograms ............................................................................................ 86 

Using the Population Hierarchy .................................................................................................. 88 

Well Populations and Well Type Populations ............................................................................ 91 

Logical Populations...................................................................................................................... 92 

Histogram Settings ....................................................................................................................... 94 

8 Statistical Analysis Using HyperView® Analysis .................................................................... 99 

Statistics ................................................................................................................................... 99 

Selecting Statistics to Calculate ................................................................................................. 99 



 

  III    

         
 

Population Statistics .................................................................................................................. 100 

Well Statistics ............................................................................................................................. 101 

Excel Export ................................................................................................................................ 102 

Results ................................................................................................................................... 103 

Creating Heat Maps .................................................................................................................... 104 

Heat Map Settings ...................................................................................................................... 108 

Export Well FCS .......................................................................................................................... 110 

9 Advanced Features of HyperView® Analysis ........................................................................ 113 

Compensation ........................................................................................................................ 113 

Enabling and Disabling Compensation.................................................................................... 114 

Adding Compensation ............................................................................................................... 114 

Editing Compensation ............................................................................................................... 116 

Preferences Settings in HyperView Analysis ......................................................................... 117 

View Menu Options ................................................................................................................ 118 

Plate Summary ............................................................................................................................ 119 

Analysis Summary ..................................................................................................................... 119 

Saving and Exiting ................................................................................................................. 120 

Appendix A Configuring Your HyperCyt® Using IntelliCyt Manager ..................................... 122 

Settings Tab ................................................................................................................................ 122 

Licensing Tab ............................................................................................................................. 125 

Users Tab .................................................................................................................................... 127 

User Groups Tab ........................................................................................................................ 128 

Connections Tab ........................................................................................................................ 130 

Flow Cytometers Tab ................................................................................................................. 131 

HyperCyts Tab ............................................................................................................................ 133 

Appendix B User Tips ................................................................................................................ 135 

Sample Carryover ....................................................................................................................... 135 

Appendix C Additional User Information ................................................................................. 138 

Importing and Exporting an Experiment in HyperView Designer ......................................... 138 

Importing and Exporting Analyses using HyperView Analysis .............................................. 140 

Import and Export CSV Plate Designs Using HyperView Designer ...................................... 142 

Attaching and Clearing FCS Data Using HyperView Designer and HyperCyt Controller ...... 146 

Exporting FCS Data using HyperView Designer and HyperView Analysis ........................... 149 

Changing Default Colors in HyperView Designer .................................................................. 152 

Managing Experiments in HyperView Designer .................................................................... 153 

Managing Analyses in HyperView Analysis ........................................................................... 155 

Appendix D Troubleshooting .................................................................................................... 159 



 

IV   

Powering the System ............................................................................................................. 159 

Autosampler Control .............................................................................................................. 159 

Fluidic Sample Delivery Troubleshooting Guidelines ............................................................ 161 

Interpreting Flow Cytometry Results in Troubleshooting Fluidic Sample Delivery ................ 163 

 

 

 

 

 



 

  V    

         
 

 

Introduction 
The HyperCyt® System rapidly acquires samples from a multi-well microplate to perform high-throughput 
flow cytometry. As a modular add-on for new or existing flow cytometers, the HyperCyt System is 
designed to acquire samples in a variety of 96- and 384-well microplates. 

High-throughput sample acquisition is achieved by the HyperCyt Autosampler software module, which 
utilizes an innovative, patented sampling method. As the sampling probe of the autosampler moves from 
well to well in a multi-well microplate, a peristaltic pump aspirates sample particle suspensions from each 
well. Between each well the continuously running pump draws a gap of air into the sample line, resulting 
in the generation of a series of air-gap-separated samples for delivery to the flow cytometer. Sample and 
air-gap volumes are determined by the time that the autosampler probe is in a microplate well or above a 
well drawing in air. The user can define the amount of time the sample probe is in the well or in the air, 
thus controlling the quantity of specimen for analysis. 

As the air bubble-separated samples are delivered in a continuous stream to the flow cytometer, the data 
are collected in a continuous fashion and the accumulated data from all wells of a microplate are collected 
in a single data file. The time-resolved data, with periodic gaps corresponding to the passage of the 
sample-separating air gaps, are analyzed by the HyperView® Analysis software. 

 

In this Guide 

Chapter 1 gives safety precautions and system requirements for the HyperCyt® System. 

Chapter 2 provides an overview of the HyperCyt hardware and software and gives start up and shut down 
procedures. 

Chapter 3 gives the calibration and set up procedures for preparing for a sampling run. 

Chapter 4 describes designing an experiment using HyperView® Designer. 

Chapter 5 describes the use of the HyperCyt® Autosampler to run a plate using HyperCyt Controller. 

Chapter 6 
describes creating a HyperView® Analysis from plates that were previously run on the HyperCyt 
System. 

Chapter 7 describes the use of HyperView Analysis to analyze data populations. 

Chapter 8 continues the analysis by showing how to do statistical calculations with HyperView Analysis. 

Chapter 9 discusses additional helpful features of HyperView Analysis 

Appendix A describes the procedures for configuring your HyperCyt using IntelliCyt Manager. 

Appendix B gives user tips and how-to’s. 

Appendix C gives additional user information. 

Appendix D gives troubleshooting information. 
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Conventions 

This guide assumes that you have a basic knowledge of computers using the Microsoft Windows XP operating 
system and that you are familiar with windows, menus, commands, buttons, tabs, dialog boxes, and other Microsoft 
Windows elements. 

Throughout this guide certain terminology, conventions, and symbols are used and are described in the following 
table. 

Terminology 
Term Definition 
Click  Place the mouse pointer over the item, then depress and release the primary 

mouse button (usually the left button) in one quick motion. 
Right-click Place the mouse pointer over the item, then depress and release the 

secondary mouse button (usually the right button) in one quick motion. 
Double-
click 

Place the mouse pointer over the item, then depress and release the primary 
mouse button twice in quick succession. 

Drag Place the mouse pointer over the item, depress and hold down the left mouse 
button, then move the pointer (and the object) to some target location and 
release the mouse button. 

Press Push and release a key on the keyboard. 
Shift, Ctrl, 
Alt 

When any of these terms appear before any of the above terms, it means to 
hold down the specified keyboard key while taking the hyphenated action.  

Shortcut 
menu 

A menu that appears when you right-click an item. 

Conventions 
 Menus, menu items, dropdown lists, textboxes, buttons, and options that require user action appear in 

bold type. For example: Click Run. 

 Window titles and dialog box names begin with uppercase letters. For example: Autosampler Control 
window. 
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Text Symbols 
Symbols are used in HyperCyt® documentation to draw your attention to important information such as operating 
tips and suggestions, as well as the presence of hazards. All safety and hazard symbols are given in Chapter 1, 
“Safety Precautions and System Information.” 

Symbol Description 

 

A tip, suggestion, or additional information. 

IMPORTANT Indicates information that is necessary for proper instrument or software 
operation. 

 

Contacting Technical Support 

If you have a technical question that you are unable to answer after consulting the documentation,: 

Please contact Beckman Coulter Customer Service at 1-800-526-7694 from the United States and Canada. 
 Outside the US and Canada, contact your local Beckman Coulter Representative 

Before you contact us, it is helpful if you are prepared to answer the following questions: 

 What were you doing when the problem occurred? 

 Can you reproduce the problem? 

 Did you try to solve the problem? If so, what steps did you take and what did you observe? 

 Which error messages, if any, appeared? 

Having these answers will help us provide you with a solution as quickly as possible.  

 
WARNING

 

Use this product only in the manner described in this guide. When used 
other than as specified, the safety protections may be impaired. Failure to 
adhere to safety precautions and/or procedures outlined in this document 
may result in system failure or personal injury. IntelliCyt Corporation shall not 
be held liable under any circumstances.  
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Safety Precautions and System Information 
 

Safety Symbols 

The following symbols may appear adjacent to safety precaution statements. 

Symbol Description 

 

DANGER 
An impending hazardous situation, which, if not avoided, could result in 
serious injury.  

  

WARNING 
A potentially hazardous situation, which, if not avoided, could result in serious 
injury. When this symbol appears on equipment, consult product 
documentation to identify the nature of any potential hazard and determine 
the actions to perform. 

 

CAUTION 
A cautionary statement, which, if not followed, may result in instrument 
damage or corruption of data. 

 

Risk of Fire. 

 

Biohazard. 

 

Moving Parts – Risk of body parts, clothing, hair, jewelry, etc. encountering 
or catching in moving parts. 

 

Hazardous Voltage – Risk of shock injury.  

 

Chapter 

1 
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General Precautions 

WARNING

 

Use this product only in the manner described in this guide. When used 
other than as specified, the safety protections may be impaired. Failure to 
adhere to safety precautions and/or procedures outlined in this document 
may result in system failure or personal injury. IntelliCyt Corporation shall not 
be held liable under any circumstances.  

  

WARNING

 

BIOHAZARD!  

• Use proper laboratory practices when handling any hazardous materials. 

• Make sure that biohazards do not contaminate HyperCyt® System 
components. 

• In the event that system contamination occurs, contact Customer 
support for applicable cleanup procedures. 

  

DANGER

 

If smoke, abnormal noise, or strange odor is present, immediately shutdown 
the system and notify Customer support. It is dangerous to continue using 
the system.  

  

WARNING

 

For safe operation of the HyperCyt System, the power cords must be 
connected to a grounded outlet. 

 

HyperCyt® System Operation Precautions 

HyperCyt Instrument 

WARNING

 

 

Risk of electric shock! 

The system contains voltages that are potentially hazardous. To reduce the 
risk of electric shock, do not attempt to open either the Autosampler or 
Peristaltic Pump units. Periodically inspect power cords and plugs for proper 
condition and replace as necessary. 

ONLY QUALIFIED SERVICE PERSONNEL may perform testing or repairs. 
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CAUTION

 

MOVING MECHANICAL PARTS!  

Be aware of the range of movement of XY and Z arms of the Autosampler. 
When first turning on power to the unit the XY and Z arms automatically go to 
a preset home position. Make sure that you are out of the way of the arms 
before switching on the Autosampler. 

CAUTION

 
 

 

  

WARNING

 

Always keep body parts, hair, jewelry, and clothing away from the 
Autosampler and the Peristaltic Pump while they are operating.  

Keep all objects out of the path of the Autosampler arm and the Peristaltic 
Pump. If the Autosampler arm encounters an object in its path, the 
Autosampler will lose the proper orientation. The Peristaltic Pump can get 
jammed if something gets caught in its rotating head. 

  

WARNING

 

Once a run is started, do not add or remove plates from the plate platform 
until the robotic arm and probe come to a stop. 

 
 

WARNING

 

Risk of Fire! 

• Do not place anything on the equipment that prevents adequate 
dissipation of heat.  

• Choose a well ventilated area to position the system and provide at least 
3 inches of clearance around all sides of equipment.  

• Do not obstruct the air vents for the fans of the HyperCyt® or 
components.  

• Do not operate the equipment in an environment where flammable, 
corrosive, or other damaging liquids or gases are present. 

• Do not allow liquid or foreign objects on or inside the equipment. 

• Peristaltic Pump must reside on the HyperCyt platform.  Do not operate 
on any other surface. 

  
CAUTION

 

The HyperCyt System is not specifically protected from substances that are 
corrosive, toxic, radioactive, or otherwise hazardous. Use good laboratory 
practice and caution when using such substances in the system vicinity.  
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HyperCyt® Computer 

CAUTION

 

Loading unrelated software on the HyperCyt computer may cause system 
damage including but not limited to data corruption and/or software 
incompatibility. Do not load any software application that has not been 
provided or approved by IntelliCyt Corporation. If problems occur as a result 
of such activity, IntelliCyt Corporation has no liability and will not be held 
responsible for damages and repair costs.  

System Components 
Additional safety precaution statements can be found in the supplied documentation for the following 
system components: 

 Computer 

 HyperCyt® Autosampler (223 Sampler Changer Users Guide) 

 HyperCyt® Pump (Peristaltic Pump Users Guide) 
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HyperCyt® System Information 

Item Specification 
Dimensions (w x d x h) 22 x 17 x 19 inches (55.9 x 43.2 x 48.3 cm) 
Weight 62 lbs. (28.1 kg) 
Power  Frequency – 50-60 Hz 

 Voltage – 90-120 or 220-240 V. Voltage fluctuations not to 
exceed ±10% of the nominal voltage. 

 Current rating – One 2.0-A fuse for 90-120 V, or two 2.0-
A fuses for 220-240 V. 

Environmental 
Conditions 

 Temperature range – 5 to 40oC 
 Humidity – Maximum relative humidity 80% for 

temperatures up to 31oC, decreasing linearly to 50% 
relative humidity at 40oC. 

Tubing and Connectors HyperCyt(R)™ Tubing/Connectors kit, or recommended 
tubing/connectors only 

Fluidics  Sampling volume –. Sampling volume is user adjustable 
using HyperCyt® Autosampler Software and is determined 
by the time the probe remains in the well or tube and the 
speed of the peristaltic pump. 

 Carryover – Carryover is sample and sample size 
dependent. Typical results are: 

o 1-2% ± in no rinse format* 
o <1% with an  interwell rinse  

 
Compatible Multi-well 
Microplates 

  HyperCyt is compatible with all 96 and 384 well 
microplates.  However, it is advisable to verify the optimal 
plate for your applications. 
 

Performance 
Throughput 

 96-well Microplate – 2.5 minutes 
 384-well Microplate – 10 minutes 
Throughput performance is 40 wells/minute when aspirating for 1 
second from wells. Higher sample volumes or between well washes 
and intermittent shaking result in a higher throughput time. 

Computer   PC desktop or laptop computer with Microsoft® Windows® 
XP operating system 

 2GB RAM 
 40 GB available hard disk space  
 One serial COM port and 2  USB ports 

Software  HyperCyt® Controller Software 
 HyperView® Designer and Analysis Software 
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Setup of the HyperCyt® System 
The HyperCyt System rapidly acquires samples in a multi-well microplate to perform high-
throughput flow cytometry. As a modular add-on for new or existing flow cytometers, the 
HyperCyt System is designed to quickly acquire samples in 96- and 384-well microplates. 

System Overview 

HyperCyt System Illustration 
The HyperCyt System is illustrated showing the following main components of the system: 

 Autosampler 
 Sample Probe 
 Sample Line Tubing 
 Peristaltic Pump 
 Plate Platform 
 Microplate 
 Orbital Shaker 
 Rinse Station(s) 
 XY Horizontal Arm 
 Z Vertical Arm 
 Status Light 

Chapter 

2 
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Figure 2-1.  The HyperCyt Autosampler 

 

HyperCyt® Instrument 
The HyperCyt System has the following parts and features: 

 Autosampler – An XYZ robot that is under HyperCyt software control and positions the 
Sample Probe into and out of microplate wells and rinse stations. 

 X,Y Horizontal Arm – Moves the Sample Probe to positions proscribed by the HyperCyt 
Controller software. 

 Z Vertical Arm – Holds the Sample Probe and moves the probe up and down as programmed 
in HyperCyt Controller software. 

 Plate Platform – Holds the sample microplate. 

 Orbital Shaker – Orbital shaker, programmable for mixing samples within wells. 

 Chiller/Heater– Optional cooling and/or heating unit for regulating the temperature of 
samples. 

 Rinse Station – Holds tubes of solutions for priming, rinsing and cleaning the Sampling Line. 

 Peristaltic Pump – Pumps fluid from the prime, rinse, and clean stations, or the sample 
suspension from wells of the microplate, into the flow cytometer sample input. The pump runs 
continuously during sampling of the plate so that an air bubble is aspirated between each of the 
sampled wells.The pump must reside on the HyperCyt platform. 

 Sample Probe – The metal tube that serves as the conduit between the Sample Line Tubing and the 
fluidic sample in the microplate wells. 
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 Sample Line Tubing – The 0.25-mm (inner diameter) PVC tubing connects to the Sample Probe and 
carries specimens to the flow cytometer via the pumping action of the Peristaltic Pump. 

 

HyperCyt Computer 
The computer workstation for the HyperCyt System is a specially configured desktop or laptop computer. 
HyperCyt applications running on this computer control the essential functions of the HyperCyt instrument, 
and include the software for analyzing the data that is retrieved from the flow cytometer computer. 

Software Applications 
The HyperCyt System software includes the following software applications: 

 

IntelliCyt™ Manager 
 

The IntelliCyt Manager software application manages the administrative functions of the HyperCyt 
System.  These functions include the management of global system settings, nightly database 
backups, licensing, users, flow cytometer automation clients, and application connections.  Access 
to this application is limited to the System Administrator. 

 

HyperView® Designer 
 

The HyperView Designer allows you to create and edit your experimental parameters. You will be 
able to designate the well contents in your plate, as well as define all of the parameters for running 
the autosampler, including sampling time, shaker controls, and rinse frequency.  

 

HyperCyt® Controller 
 

The HyperCyt Controller software application controls and monitors the status of the components 
of the HyperCyt System and translates the experiments you create in Designer into a worklist to be 
performed by the device. Controller also contains the tools you need to recalibrate your HyperCyt 
each time you change the probe or add new models of plates. 

 

HyperView® Analysis  
 

The HyperView® Analysis software reads the FCS data file produced by the flow cytometer. 
HyperCyt delivers air gap-separated samples to the flow cytometer in a continuous stream, and the 
flow cytometer collects and accumulates the data in a continuous fashion from all wells of a 
microplate into a single FCS data file. HyperView Analysis software takes the data from the entire 
plate and utilizes an algorithm that identifies individual well data by applying time gates and 
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metadata from the HyperView Experiment setup.  With HyperView analysis, you can create and 
analyze gates and regions, identify and visualize data from individual wells, set or edit 
compensation, and display and export statistics and on both a well and plate level.  If desired, you 
can also export individual well data as individual FCS files. 

 

HyperCyt® Installation 

Setting Up the HyperCyt System 
Back View of HyperCyt Autosampler and peristaltic pump: 

 
Figure 2-2.  Back view of HyperCyt Autosampler and peristaltic pump connections. 

 
Make the cable connections:  

 Serial cable from the computer to the HyperCyt serial port. 
 GSIOC port on the peristaltic pump to the HyperCyt port. 
 RJ45 cable connection into the plate shaker. 
 Serial cable connection from the plate shaker to the HyperCyt computer. If your computer 

does not have an open serial port, a serial to USB Keyspan connector can be utilized. 
  

  
Plate Shaker cables Plate shaker cable attachments 

Figure 2-3.  Setting up the plate shaker. 
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1) Plug in the Autosampler unit. 
2) Plug in the peristaltic pump. 
3) Plug in the plate shaker AC adaptor. 
4) Turn on the HyperCyt and peristaltic pump. 

 
 

 
 

 
 

DANGER

 
   

   

Risk of Injury! 
Be careful not to put your hands or other body parts within the XYZ motion 
area of the robot arm of the Autosampler. 

 
Moving Parts 
The X, Y, and Z arms automatically move to a predefined home position on 
power-up.  
 

 
 

 

Figure 2-4.  Front view of the peristaltic pump. 

 
When connected to the HyperCyt, the peristaltic pump is under the control of HyperCyt Controller software 
and will indicate the speed selected in the software on the LCD window.  The pump will operate in a 
clockwise or counterclockwise fashion depending upon the configuration of the HyperCyt deck, i.e., the 
position of the pump on the deck. (See Chapter 3:  Calibrating the HyperCyt System).   

Sample Line Tubing Setup 
The peristaltic pump delivers samples from the microplate wells to the flow cytometer by positive 
displacement of fluid as it passes over the rollers of the pump head. The sample line tubing is inserted in the 
sample probe, runs through the peristaltic pump, and connects to the flow cytometer.   It is recommended to 

WARNING

 
If the status light begins blinking, there is a problem with the Autosampler. 
See Autosampler Troubleshooting in Appendix C, “Troubleshooting.” 
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replace the peristaltic tubing daily for high throughput screening.  For less frequent use, the tubing may be 
used for up to 90 hours of use if it is cleaned and rinsed thoroughly with DI water after each use. 

Connecting the probe and sample line tubing: 

 

IMPORTANT 
For the Sample Line, use only the tubing provided or recommended by 
IntelliCyt Corporation. No other type of tubing should be substituted because 
of the risk of increased carryover.  For high throughput screening, it is 
recommended that the peristaltic tubing be replaced daily. 

 
The sample line tubing comes with either one or two plastics stops. These stops are designed to hold the 
sample tubing in the correct position on the peristaltic pump rollers. One stop is approximately 18 inches 
from the end that connects to the sample probe. The remaining piece of tubing should be cut so that there is 
minimal excess tubing between the pump head and the flow cytometer. Because of differences in flow 
cytometers and the positioning of the HyperCyt unit, this length will vary for each setup. 

To connect the tubing and probe: 

1) Dip the end of the tubing into clean, hot DI water. 

2) Use the Tubing Expander to prepare the peristaltic pump tubing. 

a) Carefully insert the tubing expander into the tubing 1/4", taking care not to impale the inside 
wall of the tubing.  

 
b) Remove the expander and insert the Sample Probe 3/16” into the tubing. 

 
3)     Slide the white ferrule over the tubing-probe junction, and position the white ferrule so that 
the wide end of the ferrule is flush with the end of the tubing.  Slide the black fitting over tubing 
and onto the narrow end of the ferrule (see p. 15 for diagram). 
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4)     Insert the Sample Probe into the orange probe holder and through the stainless steel probe 
protector. 

 
5)     Screw the black fitting snugly into the orange probe holder and insert the probe assembly into 
the white probe holder on the HyperCyt instrument. 

 
 

  

IntelliCyt recommends that you prime new sample line tubing with buffer for 
10 to 15 minutes before use in order to remove trapped air or microscopic 
particles from the inner surfaces of the tubing. 

6) Place the tubing into position on the peristaltic pump (see “Peristaltic Pump Setup” below.)  

 
7)  Connect the tubing to the flow cytometer.  Insert the tubing expander into the end of the 

tubing about 1/4" to 3/8". 
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8)  Use the heat gun to gently heat the tubing with the tube expander inserted in it. You need only 
heat the tubing for about 5 – 10 seconds, holding the heat gun 1 – 2" away from the end of the 
tubing. 

 

IMPORTANT 
Some flow cytometers need an adaptor to accommodate the larger inlet 
tube. Contact Customer Support to determine the appropriate connection for 
your flow cytometer. 

 

Sample Probe Installation 
If the Sample Probe is not already installed, mount the sample probe on the Z arm. 

The Sample Probe placement and probe retaining screw are illustrated below.  

 

Figure 2-5.  Sample probe assembly. 

The diagram below shows an enlargement of the connection between the peristaltic tubing, the ferrule and 
the sample probe. The sample probe should extend 3/16” into the tubing, and the ferrule should be flush 
with the end of the tubing, as shown, for optimal probe performance. 
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Figure 2-6.  Depth of sample probe insertion into tubing. 

 

Peristaltic Pump Setup 
To prepare the pump head: 

1) Press the trigger key to release the locking key and the compression cam. 
 

2) Examine the pump rollers to make sure all surfaces are clean and that the rollers move smoothly. 
 

3) Examine the tubing for signs of wear.  If the tubing shows signs of wear, replace it before 
proceeding. 

 
Insert the tubing into the left tubing guide if the pump is located on the right side position on the HyperCyt 
deck, with the tubing stop positioned as shown in inset B. Wrap the tubing around the rollers through the 
right tubing guide.  If the pump is located on the left side of the HyperCyt deck, the tubing stop is inserted 
outside the right tubing guide.  Verify that you have the correct deck configuration selected in HyperCyt 
Controller (See Chapter 3:  Calibrating the HyperCyt).  
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Figure 2-7.  Adjusting the peristaltic pump to optimize air gaps. 

 
4) Holding the two ends firmly together, bring the compression cam into contact with the tubing and 

hold it in position while pulling the locking key snugly into place. 
 

5) Press the trigger key into the position just below the locking key. 
 
 
 

 
Optimize the sample air gaps to prepare for running a plate: 

 

The HyperCyt System must be calibrated before you can optimize air gaps. 

See Chapter 3  for detailed description. 

 

1) With the sample probe in the up position and the pump clamp open, connect the peristaltic pump 
tubing to the flow cytometer.  Put the flow cytometer in Run mode and allow the sheath fluid to 
backflush the sample line until sheath fluid is seen dripping from the HyperCyt sample probe. 
 

2) Ensure that the sample tubing is seated in the correct position on the pump head, close the 
compression cam and clamp the tubing into place by closing the Locking Key and placing the 
Trigger Key in the locked position.  Rotate the adjustment screw until no more sheath fluid is 
dripping from the sample probe. 
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3) Start the HyperCyt Controller software by double-clicking on the Controller desktop icon ( ). 
Move sample probe to the Prime position by clicking the Prime button. The sample probe will 
begin cycling up and down into the leftmost position in the rinse station, (S1 prime station) and 
continue until you press Stop. 
 

4) You should now be able to observe small volumes of fluid traveling through the tubing, separated 
by air gaps, toward the flow cytometer. Slowly tighten or loosen the Adjustment Screw until the air 
gaps are stationary.  Then tighten the screw just enough to see the gaps and fluid moving toward 
the flow cytometer. 

 

  

If air gaps are not intact when exiting the pump head, loosen the pump 
clamp by adjusting the tightening screw in a counterclockwise motion until 
the bubbles appear to stop, then slowly tighten the screw until the movement 
towards the flow cytometer resumes.  If this has not improved the quality of 
air gaps, release and reset the compression cam, assuring that the tubing is 
correctly seated. 

 

Verifying the Settings 
Speed Setting – The peristaltic pump speed should be set to 15 rpm, which results in a flow rate of about 
2µL per second.  Faster speeds will increase the sample throughput and also the size of the sample core in 
the flow cytometer and may adversely affect the resolution of the data.  Likewise, lowering the pump speed 
will decrease sample throughput, decrease the size of the sample core, and likely increase the resolution of 
the data.  Small adjustments in the flow rate may be necessary for certain flow cytometers.  Consult 
Customer Support before changing the recommended speed setting by a significant amount. 

Clamp Pressure – The peristaltic pump clamp pressure should be adjusted when running buffer fluid 
through the sample line tubing.  When properly adjusted, there are unbroken air bubbles on both sides of the 
pump.  Make sure that the flow cytometer fluidics setting is in the Run, or sampling, position. 

If you see bubbles breaking up on the flow cytometer side of the pump head, the clamp has probably been 
tightened too much or there may be a clog in the flow cytometer, probe, or tubing.   

Maintaining the Sample Line Tubing 
Before the first sampling run of the day and between all subsequent runs:  Fill the S1 rinse station with fresh 
buffer or water.  In HyperCyt Controller, click the Prime button in order to prime the peristaltic tubing with 
S1 buffer for a few minutes.  The buffer used must be appropriate for the specimen being analyzed.  For 
many cell types, 0.1% BSA in PBS is an important surfactant that helps prevent particles from attaching to 
the sample line.  The presence of at least 0.1% BSA (or some equivalent protein) in all solutions helps 
minimize particle carryover.  At the end of the day, run a clean cycle, and discard remaining buffer 
solutions. 
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IntelliCyt recommends changing tubing daily in a high volume laboratory.  If 
you reuse tubing, you will need to routinely run a cleaning cycle with 
detergent (e.g., 2.5% Contrad70) in S3, followed by deionized water in S4, 
through the sample line tubing at the end of each day, leaving DI water in the 
tubing overnight. 

 
 

 

HyperCyt® System Shutdown 

To shutdown the HyperCyt System: 

Click the red X in the upper right-hand corner of the HyperCyt Controller window. 

On the desktop, select Start > Shut down > Shutdown, then click OK.  

The computer will power down. 

Turn off the power to the HyperCyt Autosampler, the Shaker and Peristaltic Pump. 
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 Calibrating the HyperCyt® System 
Before performing a sampling run on the HyperCyt System, you must perform a series of setup procedures 
to ensure that the HyperCyt is properly configured. This chapter outlines the required HyperCyt hardware 
and software setup procedures. 

Initial Autosampler Setup 

1) Double-click on the HyperCyt Controller program icon ( ) to start the program. 
 
 

 

Figure 3-1.  The HyperCyt Controller Software. 

 

Chapter 

3 
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2) Ensure that the system is set up (as described in Chapter 2): 
a) The autosampler unit and HyperCyt computer are connected by the serial cable.  
b)  The orbital shaker is connected to the HyperCyt computer, if present. 
c) The peristaltic pump is connected to the autosampler unit. 
d) The autosampler and pump are turned on. 

 
3) The HyperCyt Controller will automatically detect and connect to the HyperCyt autosampler and the peristaltic 

pump.  Additionally, it will show the status of the shaker, if installed, and the flow cytometer, if your system is 
equipped with an automated control feature. 
If the HyperCyt Controller fails to connect to any of these devices, go back and check all connections and check 
to ensure that all devices are powered on.  When you have found the disconnected device, you can reconnect by 
clicking Reset.  If one or more devices still will not connect, contact  customer support. 

 

CAUTION

 

MOVING MECHANICAL PARTS 

Be careful not to put your hands or other body parts within the XYZ motion 
area of the robot arm of the Autosampler. 

   
The X, Y, and Z arms move to a predefined home position in this procedure. 

 
 

 

If the Sampling Probe is already mounted, loosen the retaining screw.  This 
is a safe position to begin calibration and avoid damaging the sample probe.   

Calibration of the HyperCyt® 

You have the option to position the peristaltic pump on the left or right side of the deck in order to minimize the 
distance that the sample will travel to the flow cytometer.  In the HyperCyt Controller toolbar, select Tools, click on 
HyperCyt Options, then select the “Left” or “Right” radio button. 

 

 

Figure 3-2.  Setting the location of the peristaltic pump. 

For initial setup and under some other circumstances, it is necessary to calibrate the HyperCyt by giving it the three-
dimensional locations of certain reference points.  These reference points are:  
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1) The Deck Height – The position of the autosampler Z Arm where the probe is just touching the 
plate deck in the z-axis. 

2) The 96-Well Plate Coordinates – The positions for the autosampler X,Y Arm where the probe is 
located in the center, in the x and y-axes, of the four corner wells of a standard 96-well plate. 

3) The 384-Well Plate Coordinates – The positions for the autosampler X,Y Arm where the probe is 
located in the center, in the x and y-axes, of the four corner wells of a standard 384-well plate. 

4) The Rinse Station Locations and Depths – The positions of the autosampler X,Y Arm where the 
probe is located in the center of each of the four rinse stations, and the optimal sampling depth for 
the probe. 

5) Microplate Well Depth – The position of the autosampler, for a given plate model, where the probe 
is at the desired depth at the bottom of a well.  This is established using Manage Plate Models. 

 
To begin the calibration process, in the HyperCyt Controller Tools menu, choose Calibrate HyperCyt. 

If this is the first time the system has been calibrated, you will see a First Time Calibration screen.  This screen 
allows you to set the approximate location of the center of the plate in order to make subsequent calibration steps go 
faster. 

 

 
Figure 3-3.  First time calibration screen. 

 
After First Time Calibration has been done, you will see the Calibrate HyperCyt screen. 
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Figure 3-4.  Calibration steps. 

 
Before any calibrations have been performed, a green arrow ( ) appears to the left of each calibration option.  To 
the right, the message “NOT YET CALIBRATED” is displayed.  Once calibration has been performed, this will be 
replaced with the date of the most recent calibration.  After each calibration has been performed, a green checkmark  
( ) will appear if the calibration was successful, whereas a red ‘X’ ( ) will appear if an error occurred during the 
calibration.  Once all calibrations have been successfully performed, click Done to close the window.  If you do not 
need to perform all of the calibrations (i.e. you are only using 96-well plates) you may still click Done to exit the 
calibration screen, but a message will appear to remind you that you have not performed all four calibrations. 

 
Figure 3-5.  Attempting to close without performing all calibration steps. 

 
If you have performed the calibrations you need to perform for your experiments for this session, click Yes.  
Clicking No allows you to go back and perform additional calibrations. 

Deck Height Calibration 
The deck height calibration defines the z-axis location where the probe is just touching the surface of the plateholder 
deck.  This measurement is used as a reference point for storing the probe travel height, and the plate model 
calibrated well depths (these calibrations are performed later). 

 

If you have recently modified any part of your HyperCyt which may affect the 
z-axis location of the probe, (i.e. initial setup of the system, changing probes, 
changing tubing, removing the shaker) it is necessary to perform a deck 
height calibration.   
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1) From the Tools Menu, click Calibrate HyperCyt.  

2) From this pane, click Calibrate Deck Height.  

3) While calibrating the deck height, loosen the Probe Guide Retaining Screw (see below) so that you 
do not unintentionally damage the tip of your probe.  Retighten the retaining screw after 
establishing the deck height. 

 

 

 

 

 

 

 

4) Follow the instructions in each screen of the calibration Wizard. The Wizard will direct you 
through setting the plate deck height (the absolute lowest position of the probe), and the travel 
height (the proper height for the probe to be traveling between locations where it will be able to 
clear the plate and the rinse stations). 

 

 
Figure 3-6.  Deck height calibration. 

 

For both of these adjustments, you have the option of moving the probe position in large steps 
( ) or small steps ( ).  The default step size for the large steps is 25 units, but this step 
size may be adjusted by clicking the up or down arrows.   

 

Probe Guide Retaining Screw 
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You may also make up and down movements using the up and down arrow keys on your 
keyboard.  The up/down arrow keys alone will move the probe a small increment, while holding 
the Shift key down while pressing the up or down keys will move the probe a large increment.  

 

5) For the travel height adjustment, the buttons on the right side of the panel move the probe between 
the home, rinse stations and plate positions for your reference.  

 

 
Figure 3-7.   Travel Height Calibration. 

  

6) Once you have positioned the probe at the desired travel height, click Finish to save your 
calibration settings.  The probe will return to its Home position, and the calibration settings will be 
saved until your next calibration. 

 

Calibration of Plate Coordinates 
This calibration is necessary in order for the autosampler to have a record of the coordinates of the four corner wells 
of a standard multiwell plate.  This calibration is important, since these coordinates are used to reference the location 
of all wells in the plate.  A 96-well microplate is used as an example in the following procedure.  You will follow the 
same process to calibrate a 384-well plate.  

1) Place a 96-well plate in the plate holder, with well A1 in the upper left hand corner, as shown. 
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Figure 3-8.  Sample plate and rinse station locations. 

 

2) From the Tools menu, click Calibrate HyperCyt. 
3) From this window, click either Calibrate 96-well Plate Coordinates or Calibrate 384-well Plate 

Coordinates. 
4) Follow the Wizard instructions for calibrating the positions of the four corners of the plate.  You can 

use the large or small step arrows to adjust the position for X and Y until the probe is centered in the 
well.  It is recommended that you use the Raise and Lower Probe buttons to position the probe just 
below the surface of the plate so you can better visualize the center of the well, being careful not to let 
the probe crash into the plate.  Lowering the probe does not set the sampling depth in the plate 
calibration mode.  This is recorded by plate model in the Manage Plate Model menu. 

 

 

Figure 3-9.  Sample plate location calibration. 
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5) After each corner position has been centered, click Next to go to the next corner position.  
6) Once all four coordinates have been centered, click Finish to save your calibration settings. 

 

Rinse Station Position Calibration 
Your HyperCyt system has four rinse stations, located behind the plate deck, labeled S1, S2, S3 and S4. The topmost 
physical feature of any rinse station should be no higher than the topmost feature of the microplate being used.  
Typically15-ml conical test tubes containing rinse solutions are placed in the four holes in the rinse platform.  The 
rinse station designated S1 is always used for priming the HyperCyt system.  The solution in this reservoir should be 
the same buffer as that in which your cells or beads are suspended. 

1) From the Tools menu, click Calibrate HyperCyt. 
2) From this pane, click Calibrate Rinse Station Locations and Depths. 
3) Follow the Wizard instructions for setting the positions for each of the four rinse stations.  As in the 

Plate Coordinates Wizard, you can position the probe using large or small steps for X and Y until you 
have the probe centered in each of the rinse station tubes.  You can use the Raise and Lower Probe 
buttons to position the probe for optimal visualization. 

 

 

Figure 3-10.  Calibrate location of rinse stations. 

 

4) After each rinse station has been centered and the proper depth for sipping has been reached, click Next 
to go to the next position. 

5) Once all four rinse stations have been positioned, click Finish to save your calibration settings. 
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S3 and S4 are designated Clean stations. At the end of an experiment, fill S3 
with cleaning solution (2.5% Contran or 10% bleach) and S4 with deionized 
water.  Then press the Clean button.  The probe will cycle in and out of S3 
for 5 minutes then move to S4 for 5 minutes.  Turn off the peristaltic pump 
after the clean cycle. 

 
 

Managing and Calibrating Plate Models  

The HyperCyt Controller stores the calibration information for specific plate models, so that you can easily switch 
between plates with different well depth.  It does so by recording the difference between the well depth of the plate 
you are calibrating and the HyperCyt plate holder/shaker height.  If you have a model of plate that is not in the list of 
plate models, or if you have experimental requirements (i.e. a specific depth that you want to sample), you can enter 
or edit that style of plate and save it as a unique designated name.  

Adding a New Plate Model 
1) From the Tools menu, choose Manage Plate Models.  

 

 
Figure 3-11.  List of currently defined plate models. 

This window will contain a list of any plates used previously on this device, as well as a generic 96-
well and 384-well plate.  If the plate you are using is not already on the list, you will want to add it and 
define its well-depth for the autosampler.  

2) To add a new plate, click Add. A new window will pop up called Add Plate Model. 
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Figure 3-12.  Defining a custom plate model. 

 

3) Enter the name of the new plate in the field labeled Model.  If the manufacturer has been entered 
before, locate it in the dropdown menu under Manufacturer.  If the manufacturer does not appear 
in that dropdown list, you may enter it by simply selecting the empty box from the top of the 
dropdown menu and typing in the manufacturer’s name.   

4) Under Plate Type, select either 96 well or 384 well.  This will link the plate to the stored 
coordinates for the plate type. 

5) Click Save to save this plate model to your list. 

 

Calibrating the Well Depth for a New Plate Model 
The first time you use a new plate model on your HyperCyt Sampler, you will need to calibrate the well depth for 
that plate.  

1) From the Tools menu, click Manage Plate Models. 

2) From the list of plate models, click on the name of the model you will be using.  It will appear highlighted. 

3) Click on Edit. This will bring up the Edit Plate Model window. 

 



  Chapter 3 Calibrating the HyperCyt System  31 

  

 
Figure 3-13.  Editing a plate model. 

 

4) Place a plate of that model on the plate platform, and click Calibrate.  The Calibrate Plate Wizard will 
appear. 

5) Follow the instructions on the screen for performing the plate calibration.  The Sampler will move the probe to 
location A1.  Use the up and down arrows to position the probe at the well depth you prefer for this plate.  

 

 
Figure 3-14.  Calibrating the well depth of a newly defined plate model. 

 

6) When you are satisfied with the vertical position of the probe, click Finish to save the setting and exit the 
Wizard. 

7) If you would like to designate this plate as the default, click Make Default in the Edit Plate Model window.  
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8) Click Save to save that plate setting and close the window. 

 
If there are plates that are in the Manage Plate Models list that are not being used, you may either delete them, by 
selecting the plate from the list and clicking Delete, or you may hide them from view, but keep them for future use 
by selecting them from the list, then clicking the Inactive radio button at the top of the window.  You can then go 
back later and click on the Inactive radio button to see all plate models that have been inactivated and change any of 
them back to active by clicking the Active radio button. 

 

View Calibration Summary 

You can view your calibration settings by selecting View Calibration Summary from the Tools menu.  From here, 
you may copy and paste the current settings into a text file for future reference, if desired. 

 
Figure 3-15.  Summary of calibration values. 
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Design and Setup of an Experiment 
Before sampling a plate using the HyperCyt, you will want to record the contents of each well and 
give the HyperCyt specific instructions about how it should be sampled.  The HyperView Designer 
allows you to create and edit all of your experimental parameters.  When you have completed a 
sampling run you can attach an FCS file to the experiment and access all of the experimental data 
for analysis.  You will be able to identify the well contents of your plate, as well as define all of the 
parameters for running the autosampler, including sampling time, shaker controls, and rinse 
frequency.  

Creating a New Experiment in HyperView® Designer 

Double-click on the HyperView Designer icon ( ) to open the application.  You can open a previously 
saved experiment or create a new one.  Select File/Recent Experiments to see a list of a your recently used 
experiments.                         

 
Figure 4-1.  Opening a recent experiment design. 

 
 
For a new experiment: 

 
 Click on New Experiment.  A New Experiment dialog box opens. 

Chapter 
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Figure 4-2.  Creating a new experiment. 

 
Type the name of the experiment in the field beside Name near the bottom of the window.  

Note:  The name must start with a letter or a number and can contain letters, numbers, parentheses, 
underscores and dashes ( _-),  but no other symbols. 

Select drop-down arrow next to Plate Type to choose a 96 well or a 384 well plate type. 

Press Create to open the new experiment template.  After creating an experiment, Press Save Experiment 
in the toolbar.  If you open an existing experiment and want to save it under a new name, save the changes 
by clicking on File in the menu bar, then on Save Experiment As on the drop down menu.  

 



36   Chapter 4 Design and Setup of an Experiment 
 

 

 

Figure 4-3.  A new experiment in the HyperView Designer workspace. 

The HyperView Designer workspace has a plate visualization area and on the left of the workspace, below 
the toolbar, a series of tabbed sections which contain all the tools for defining the experiment.   

Experimental Setup 
Experiment:  In this pane, your experiment name is displayed.  In the Notes section, you can add 
information that you would like to keep with the experiment.  Toggle on the arrow under Plate Model to 
choose the brand of plate that you are using for this experiment.  If you do not see the plate model you are 
using, you can use HyperCyt Controller to define a new plate model.  (See Chapter 3, p. 29 for more 
discussion on Plate Model management).  

CAUTION

 

It is important that the selected plate model corresponds to the type of plate 
you are using for the experiment.  The plate model defines the depth that the 
probe sips into a well.  Using the wrong plate model could result in improper 
sampling or cause the probe to crash into the plate, damaging the probe. 

 

Locking Experiments:  Once you have completed your experiment design, you have the option of locking 
it using the Lock button.  This makes the experiment read-only, preventing future changes from being 
applied to your experiment design.  After the experiment is locked, you can save additional changes to a 
new experiment by clicking Save As in the File menu.  To unlock a locked experiment, click the Unlock 
button (this button is located where the Lock button used to be). 

Plates:  In the Plates pane, you can create and manage plates in both single and multiplate experiments. 
These features are discussed in Designing Multiplate Experiments, on p. 47. 

 Team Members:  Your name will appear under Name in the Team Members pane.  Additional 
individuals who are registered as Users in the HyperCyt system can be added as Team Members for the 
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experiment.  Those users will have the ability to edit, run, or view experiments.  See Appendix A for more 
on configuring users in IntelliCyt Manager.  

Click Add to bring up other individuals to add to the Team.  An Add Team Members dialog box appears. 
Highlight the desired name(s), and click Add.  To select non-adjacent names, click the Ctrl key on the 
keyboard while highlighting the names. 

 
Figure 4-4.  Add a new team member to your experiment. 

 
Team members can be deleted also by highlighting the  member’s user name and clicking Delete.   A dialog 
box appears that asks “Are you sure you want to delete the selected team member(s)?”  Click Yes to delete 
or No to keep the individual as a Team Member. 

 

 
You cannot delete yourself from the Team Members List. 

 
 

Using HyperView® Designer Workspace to Define a Plate 
To select wells to be sampled, click and drag across the desired wells on the diagram on the right of the 
window.  Then, assign a specimen category (Empty, Test Sample, Positive Control, Negative Control, 
Rinse, and Non Test Sample) to wells by clicking the appropriate icon at the top of the window.   

To select non-adjacent wells to assign to the same sample type, click and hold the Ctrl key while selecting 
the wells. 

The wells become the color corresponding to the selected sample category.  In this way, the wells can be 
identified for further analysis in the HyperView® Analysis program.   
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Figure 4-5.  Available well types. 

 

 

You can change the default colors for the specimen categories, if desired. 
See the section on changing default colors in Appendix C. 

 
 
Well types: 
 Empty – The well will not be sampled.  
 Test Sample – A well is sampled and data are given the tag Sample. 
 Negative Control – A well is sampled and data are given the tag Negative Control. 
 Positive Control – A well is sampled and data are given the tag Positive Control. 
 Rinse – A well contains a rinse fluid, is sampled, and data are given the tag Rinse.  

This could be useful in developing assays and characterizing carryover. 
 Non Test Sample – A well contains fluid, is sampled, and data are given the tag Non 

Test Sample.  This could be useful when screening compound libraries wherein a 
given well or wells contain no compounds. 

 
 

Sample Settings 
The Sample Settings tab creates the settings for the worklist that the HyperCyt Controller will use when 
sampling the plate.  The Sample Settings panes, Prepare, Sample, Rinse, Shake, and Flush & Clean, can 
be collapsed or expanded by clicking on the double arrowhead to the right of the header. 

1) The Prepare pane contains the steps that HyperCyt Controller will perform prior to sampling a plate, 
such as priming the sample tubing, and shaking the plate prior to sampling the plate. 

a) Enable Automatic Prime – Check the box to activate, then choose the duration and type of 
priming.     

i) Duration (s) designates the number of seconds to prime the tubing going to the flow 
cytometer before beginning a sampling run.  The default value is 30 s, and this duration is the 
minimum allowable. 

ii) Cycle Up/Down priming inserts an air gap between fluid aspirated from S1 by cycling in and 
out of S1.  Priming continues for the selected duration of time. 

iii) Continuous priming positions the probe in the S1 Prime station for the designated Duration of 
time, and aspirates fluid continuously.   

b) Enable Pre-Plate Shake activates the orbital shaker to deliver a series of 
clockwise/counterclockwise movements to the plate immediately prior to sampling.   
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i) Duration:  Enter the time duration that will mix your specimen adequately.  This will vary by 
plate model, sample type and treatment.  

ii) RPM of the shake can be modified here by typing or toggling on the arrows to the right of the 
parameters.  The defaults are 30 seconds and 2000 rpm, but will need to be optimized for the 
type of plate, and volume and type of specimens being sampled. 

iii) Cycle Probe while Shaking: select this option if you would like the probe to cycle in the 
priming fluid during the pre-plate shake, otherwise the priming will be continuous. 

 

 
Figure 4-6.  Customizing the sampling settings with the Prepare and Sample panes. 

 

2) The Sample pane contains the functional operations that affect the amount of sample that is aspirated 
and the order in which the plate is sampled.   

a) Sample Order – Click the radio button next to the diagram that indicates the order in which the 
sample probe will sample the plate.  The time to sample the plate can be decreased by selecting the 
second ( ) or fourth ( ) choice under Sample Order to eliminate extra travel time of the 
X, Y arm between rows or columns.    

b) Sip Time is the duration that the probe is in a well.  The amount of time in the well, in conjunction 
with the sample depth and the pump speed, will determine the volume of fluid that is sampled.  The 
minimum allowed Sip Time is 100 ms; the maximum is 60 min. 

c) Up Time is the amount of time the probe pauses in the “Travel Height” position and thus draws in 
air between wells.  The travel time between wells in a plate can add to the amount of air that is 
aspirated into the sample probe between samples.  The minimum allowed Up Time is 0 ms; the 
maximum is 60 s. 

d) Pump RPM is the revolutions per minute of the peristaltic pump head.  This speed controls the 
rate of sample delivery to the flow cytometer.  The default value is 15 rpm.  Allowable pump 
speeds are between 0 and 48 rpm. 

Type or toggle the arrows next to Sip Time, Up Time, and Pump RPM to adjust the values 
for these parameters. 

 
3) The Rinse pane allows you to elect to rinse the probe periodically at a designated rinse station during 

sampling with a range of frequency from every well to every 96 wells.  
 
a) Enable Probe Rinse – Click to place a check mark in the box to activate a rinse.  
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b) After every __well(s) – Enter a number in the box or use the up and down arrows to increase or 
decrease the number of wells sampled between probe rinses.   

c) Station – After the selected number of wells, the probe will cycle through each rinse station from 
the list, in order.  To insert a new rinse station, click Add.  An Add Rinse dialog box will appear 
with station placement options.  Stations are numbered from left to right:  S1, S2, S3, S4, and are 
located in the back of the sampling platform.  You can also select a station from the rinse pane and 
Edit the rinse time.  

  
 

 
Figure 4-7.  Adding rinses to be performed during a sample run. 

 
 

 

A suggested list of solutions for each station is as follows: 
Station 1:  Sample buffer 
Station 2:  Additional rinse fluid or sheath fluid 
Station 3:  2.5% Contrad, Coulter Clenz or 10% bleach 
Station 4:  Deionized water 
Each of these station containers should be filled to the very top with the 
appropriate fluid. 

 

4)  The Shake pane controls the shaker during the sampling run.  During the period of time that the shaker 
is activated, the sample probe travels to a designated rinse station to provide a rinse period and avoid  
introducing a large air gap. 

 

 
Figure 4-8.  Customizing shaker settings. 

 

a) No Shake will disable the shaker during the sampling run.  
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b) Inter-well Shake allows you to choose to have the plate shaken intermittently at a specified 
frequency. 

i) You may set the RPM of the shaker by clicking the up and down arrows next to RPM or by 
typing the desired number in the box. 

ii) You may also define which rinse station location to utilize during an inter-well shake. The 
options are rinse stations S1 – S4, the number-of-wells increment the shake will occur, and the 
duration of the shake. 

  

 

The rinse station and duration you choose in the Shake settings are in 
addition to the settings for Rinse. Keep this in mind when arranging your 
inter-well rinses, so as not to create unnecessary sample gaps. 

 

c) Continuous Shake will enable shaking from the beginning to the end of the sampling run.  

i) You may set the RPM of the shaker by clicking the up and down arrows next to RPM or by 
typing the desired number in the box.  

 

 

If using the Continuous Shake mode, it is critical that the probe be correctly 
centered for each well and that the tip is lowered deep enough into the well, 
so that the probe is not sipping from the vortex that could be generated by   
Continuous Shake. 

  

 

The order of rinsing and shaking depends on the order that you added the 
parameter in HyperCyt® Designer.  Thus, the plate can be shaken prior to 
rinsing, if the settings are added in that order.  The order can be seen when 
the design is opened in HyperCyt Controller.  It is listed under the Worklist 
section of the Status tab. 

 
 

5) The Flush and Clean pane controls the sample probe after a plate has been sampled.  
 
a) Flush Duration is set at a default value of 60 sec and will aspirate from S1.  You may enter a 

lower value but ensure that you enter a time that guarantees that all of the samples from all the 
wells have passed through the laser detection section of the flow cytometer.  The minimum 
allowed Flush Duration is 30 s. 
 

b) Enable Post-Plate Clean:  Select to perform a “mini clean” between plates.  Use the Add button 
to configure your cleaning cycle. 
 

c) Add allows you to designate a rinse station from the list of S1 – S4 and enter a period of time. 
Sequential Rinse stations can be added to the list to enable a series of rinse steps. 
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Figure 4-9.  Adding cleaning options. 

 

Post-Plate Clean is optional and the decision to use it depends on sample type, or duration of 
sampling the plate. 

 

 

Both the HyperCyt and flow cytometer should be fully cleaned at least daily. 
You can do a full clean by pressing the Clean button in HyperCyt Controller.  
This will aspirate, cycling up and down for 5 minutes each in S3 and S4, with 
the probe returning to the home position at the end of the cycle. 

 

Contents 
The Contents tab allows you to add well-specific information such as compound name, cell type, etc.  
Contents are added on a per-well per-plate basis.  This information will be exported as metadata when a 
single file is generated for an individual well. (See Chapter 6 – Exporting all Well Data) 

Create a Content List: 

Under the heading in the lower left side, click Add to enter the first type of content you would like to list. 
An Add Content dialog box appears.  Type in the name or description, such as a compound or cell type, into 
the field under Content Name and click Add. 
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Figure 4-10.  Editing the contents list. 

 

 

If you wish to annotate the content name with a concentration, you can enter 
the unit (ng/ml, cells/ml, etc.) here.  Or, you can add concentrations and 
further annotations to contents on a per-well basis in subsequent steps.   

 
Your entry or entries now appear under Name in the Contents List. 

Associating Contents to Wells: 

1) To assign items from the Contents List to specific wells, click on the content name in the 
Content List. 
 

2) Click and drag across the wells in the HyperCyt Designer workspace to select the wells that 
you want to annotate with the selected content. 

 

 
Figure 4-11.  Assigning contents to wells. 
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3) Click Assign at the bottom right of the Contents List section.  The content will now also 
appear in the Contents of Selected Wells in the section above the Contents List and yellow 
circle will appear on the well(s) to which content was assigned. 

 
Repeat the previous 3 steps to assign more content items.  

If you wish to add an annotation for the contents (for example, concentration or other identifier), highlight 
the wells that will have the same concentration value, then select the content under Content of Selected 
Wells. 

Click Edit in the Contents of Selected Wells section. 

An Edit Contents dialog box appears. Type in an alphanumerical concentration or annotation and click 
OK.   

 
Figure 4-12.  Adding annotations to the contents of specific wells. 

 
The value will now appear under the Concentration header in the Contents of Selected Wells.  To add 
more concentration values, repeat the steps above. 
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Figure 4-13.  Your content annotations appear when the well is highlighted. 

 

You can check your well assignments by clicking on the well(s) of interest.  The content assignment for that 
well or group of wells appears in the Contents of Selected Well(s). 

 

Deleting content assignments: 

If you are editing an existing experiment or notice a mistake in a content assignment you can easily delete it.  
Highlight the wells where you want to delete the contents, then, under Contents of Selected Wells, click on 
the appropriate content assignment.  You can click Edit to change the value annotation for these wells, or 
click Delete to remove this content entirely from the selected wells. 

If you have many undesired content assignments in a well, you can delete all of them in one operation.  
Highlight the wells where you want to make the changes. Then, right click.  A menu will pop up.  Select 
Clear Contents.  This will delete all content assignments in the selected wells.   
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Figure 4-14.  Clearing all content assignments from the selected wells. 

Alternatively, you can select Clear Contents from the Edit menu in the taskbar, after highlighting the 
appropriate wells. 

 

 

Figure 4-15.  You can also clear all content assignments from the Edit menu. 

If you want to make a change in a sample category (positive control, test sample, etc), you can do this by 
selecting the wells of interest and then clicking on the respective sample category.  Observe that the 
contents will not change, so if there is a change you want to make there also, you can easily reassign content 
by following the same steps as in the initial assignment or by highlighting the respective  content(s) and 
well(s) in the Contents of Selected Wells section and clicking Delete.   
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Figure 4-16.  Selecting wells by sample type. 

 
After you have completed the experimental design, click the Save icon or click on File in the menu bar, 
then on Save Experiment or Save Experiment As in the drop down menu. 

Now you are ready to run the experiment using HyperCyt Controller to control the delivery of samples to 
the flow cytometer. 

 

Designing Multiplate Experiments 

You can add multiple plates to your experiment using the Plates pane of the Experiment Setup tab.  Click 
Add to add one or more new plates.  You can choose how many plates to add, and whether you would like 
to copy the plate layout of an existing plate.  If you choose to copy a layout, you also have the option of 
copying content settings.  Click OK, and your plates will be added to the grid. 

 

 



48   Chapter 4 Design and Setup of an Experiment 
 

 

 
Figure 4-17.  Adding additional plates to your experiment design. 

 
You can switch which plate is currently displayed by clicking on its name in the list.  The text box in the 
upper left hand corner of the plate design view shows the current plate name, and allows you to change the 
name of the current plate. 

If the All Plates button in the toolbar is highlighted, any changes you make to the well assignments of the 
current plate will be applied to all plates in the experiment.  Click the All Plates button so that it is not 
highlighted if you would like to edit plate layouts individually.  Note:  the All Plates setting does not apply 
to Contents assignments – for these, you will have to assign each plate individually.  Sample Settings 
always apply to all plates in the experiment. 

 

Figure 4-18.  Working with a multiplate experiment.  “All Plates” is not highlighted, so 
changes only apply to the current plate. 
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Importing Multiple Experiments  

In cases where experiments have been created or analyzed on another computer, you may 
want to import a number of experiments at a given time.  You can import experiments into 
HyperView Designer or Analysis and also into HyperCyt controller.. 
 
1) From File, select Import/Experiments and you will see a dialog box: 
 
 
 
 
 
 

 
 
2)  Import Experiment 
 
The upper box in the dialog allows you to select one or more iex files for import.  Click the 
“Add…” button to bring up an explorer window that lets you select one or more iex files: 
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3) Select  IEX files to Import (IntelliCyt Experiment Files) 
 
You can use the SHIFT  and CTRL keys to do the normal extended select operations.  When 
you click “Open” the selected files are added to the IEX Files to Import dialog.  Any duplicate 
files or files without the .iex extension are not added: 
 
 

 
 
You can select one or more files and click “Remove” to remove them from the import list and you can also 
click “Add…” multiple times to bring in iex files from multiple folders. 
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4) Import into Project Folder 
 

This field allows you to specify the project folder (if any) to import the experiments into.  Click 
“Browse…” to launch the Select Project dialog 
 
You can use this dialog to Add, Delete and Rename project folders just as you can in the 
Manage Experiments dialog.  Once you have selected a project folder, click “OK” and the full 
path to the folder will be shown in the Import dialog 
 
 

 

: 
Note that you can click “Clear” to clear your project selection and 
you can click “Browse…” again to change you selection. 
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5) Lock experiments / analyses after they are imported 

Check this check box to cause any imported Experiments and Analyses to be marked as 
locked after they have been imported. 

 
 

 
 
 
 
Note that when importing Analyses, both the Analysis and its containing Experiment will be locked. 
 
 
6) Import Confirmation 

After one or more items have been imported, a confirmation dialog will display in the Designer, 
Controller and Analysis. 
 
 

 
 

 
 
 
 
 
 
 
 
 

The last item imported is opened in the application. 
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Using the HyperCyt® Autosampler to Run a Plate 
Sampling an Experiment Using HyperCyt® Controller 

Once you have created an experiment in HyperCyt Designer, you are ready to sample your plate using the 
HyperCyt Controller. 

   
Your HyperCyt autosampler must be calibrated before you can sample your 
experiment.  You can check when the most recent calibration was by clicking 
on Calibrate HyperCyt… in the Tools menu.  Calibration instructions are in 
Chapter 3, p. 22. 

 

HyperCyt Controller Startup 

1) Double-click on the HyperCyt Controller program icon ( ) to start the program. 

2) The HyperCyt Controller will automatically detect and connect to the HyperCyt Sampler and the 
peristaltic pump. Additionally, it will show the status of the Shaker, if installed, and the flow 
cytometer, if your system is equipped with an automated control feature. 

 

 
Figure 5-1.  Device status panel. 

 
If the HyperCyt Controller fails to connect to any of these devices, verify all connections and ensure that all devices 
are powered on.  When you have found the disconnected device, you can reconnect by clicking Reset.  If one or 
more devices still will not connect, contact  customer support. 

If the HyperCyt has not been calibrated for the type of plate you will be using, perform the calibration steps as 
described in Chapter 3, p.29.  Although the x and y coordinates should not change for various plate models, the 
depth is quite variable and should be set using Manage Plate Models.  

Chapter 
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CAUTION

 

For best operation, be sure that the plate model selected in your 
experiment design corresponds to the model you are using, and 
that the plate model has been correctly calibrated.  The plate 
model calibration determines the depth that the probe sips in a 
well.  If this is incorrect, the probe can crash into the plate and 
be damaged. 

 

There are four control buttons on the top right of the main panel:  Prime, Run, Clean and Stop. 

 

 
Figure 5-2.  Autosampler controls. 

 
Notice that only two of the buttons are clickable without an experiment open:  Prime and Clean.  

Prime will start the peristaltic pump and move the sample probe to the reservoir in Rinse Station position S1, and 
cycle up and down using a 1000ms (1 second) sip time and a 1000ms up time and continue until you click Stop.  

Clean will turn on the peristaltic pump and sample up and down for five minutes each in Rinse Station positions S3 
and S4, then return the sample probe to the home position. 

To run a new experiment: 

Click on the File menu and choose Open Experiment or Recent Experiments.  Locate your experiment and click 
Open. 

You will see the plate setup you created in HyperView® Designer:  
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Figure 5-3.  Experiment design loaded into HyperCyt Controller. 

In the top left, above the Devices pane, will now be two tabs, Status and Sampling Setup. By default, the Status 
tab will be open, showing the Devices pane and the Worklist pane.  The Worklist pane shows the entire list of 
operations that the Autosampler will perform in order to carry out the experiment, in chronological order.  The 
wells that are in the worklist will be highlighted on the plate diagram. 

By clicking on the Sampling Setup tab, you can review the settings that you created in HyperCyt Designer.  These 
settings will be broken up into different panels, representing the different functions of the device.  The sampling 
setup tab display is similar to the sample settings tab in HyperView Designer. 

 
Figure 5-4.  Reviewing the sampling setup. 
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Click on the arrow at the right of a tab to minimize any sections you do not wish to see, or to expand a minimized 
section.  You may need to scroll down in order to see all of the settings.  If there are any changes that need to be 
made, reopen the experiment in HyperView Designer, change them and click Save.  Your changes will appear in 
Controller almost immediately.  

Load your plate onto the Plate Platform, making sure that sample well A1 is in the corner closest to the sample 
probe default location (see orientation in the figure on page 26). In most setups, this will be the upper left corner. 

Click Run. The Sampler should now perform the tasks described in the Worklist, highlighting the task currently 
being performed. If your flow cytometer is not equipped with an integration module to automatically begin 
acquisition, manually begin the acquisition by the flow cytometer now, using its acquisition software. 

Should you need to stop sampling at any time during the process, click Stop and the sampler will stop at that point 
in the worklist and return to its home position.  Note that when you resume sampling, it will begin at the beginning 
of the worklist. 

Once the HyperCyt has finished sampling the plate and delivering it to the flow cytometer, manually stop recording 
the acquisition using the flow cytometer software. HyperCyt Controller will prompt you with a dialog box: 

 

 
Figure 5-5.  Attaching FCS data to an experiment. 

 
Clicking on ‘Yes’ will take you to a file dialog where you can locate and attach the associated FCS file to that 
experiment.  Doing so will enable you to keep the well contents, worklist and the resulting FCS file linked for 
analysis in HyperView Analysis (see Chapter 6).  

Once all experiments have been sampled and you have finished acquiring, you may close the HyperCyt 
Controller program by choosing Exit from the File menu, or by clicking the “X” in the upper right corner of the 
program frame. 

 

Sampling a Multiplate Experiment 

If your experiment contains more than one plate, you will notice a navigation bar at the bottom of the plate view.  
Clicking on a plate icon will set that plate as the current plate.   

Once the plate design and worklist are loaded, click on Run to sample the current plate.  A cog icon ( ) appears 
on the plate’s navigation button to indicate that it is currently running.  
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Figure 5-6.  Sampling a multiplate experiment using HyperCyt Controller. 

After the run has completed, you will be prompted to attach the FCS file.  Doing so will change the plate’s icon to a 

green checkmark ( ).  Alternatively, you can attach FCS data to the current plate at any time by choosing 
Attach FCS from the File menu. 

   
In a multiplate experiment, you can choose to run plates in any order. 

 

Manual Control Mode 

Manual Control allows you to move the probe to any position on the deck and aspirate fluids from a well or a 
rinse station without opening an experiment.  The Manual Control mode has been included in the HyperCyt 
Controller software to allow you the flexibility to perform whatever tasks you need when setting up for a real run.  
This feature can be useful when new peristaltic tubing is installed, since you will be able to run fluids from any 
reservoir.  Manual Control is also useful if you want to run compensation controls from the plate rather than tubes. 

To access the Manual Control Mode, go to the Tools menu and click Manual Control Mode.  
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Figure 5-7.  Manual controlling the HyperCyt autosampler. 

When in Manual Control mode, it is very important to be certain to choose the type of plate you are using.  
Choosing the wrong kind of plate could result in damage to the sample probe if it crashes into the plate. 

From the Plate Model dropdown menu, choose either a 96-well or a 384-well plate.  The dropdown list below it 
will populate with any plate models in the database for that well number.  Choose the specific plate model you have 
loaded onto the plate deck.  You can create new plate models, if necessary; this procedure is described in Chapter 3, 
p. 29. 

In the Pump Control panel, you may manually start the pump running by checking the box marked On.  You can 
change the speed setting in increments of 0.1 RPM using the up and down arrows for RPM.  You also have the 
option of rapidly running fluid through the pump by clicking on the checkbox marked Rabbit Mode.   

CAUTION

 

 Be sure that the flow cytometer is in Run mode before pumping sample or buffers into it. 

 

If desired, you can set the plate to shake using the settings in the Shaker Control panel.  Check the box labeled On 
to start the shaker.  Adjust its speed by clicking the up and down arrows for RPM. 

 

Moving Around the Plate in Manual Control Mode 
In the Probe Location panel of the Manual Control Mode, the components will look very much like your 
experimental setup, but now all of the locations are active.  Click on a well or rinse station to send the probe to that 
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location. That location will become highlighted on the screen and the probe will move to the x and y coordinate for 
that location. By default, the probe will position itself at its z-high position.   

 
Figure 5-8.  Navigating the deck in manual control mode. 

 
Once the probe is positioned over a well or rinse station, you can lower the probe into its calibrated sampling 

position by clicking the bottom down arrow under the z-axis ( ).  If you then click on another well or rinse 
station position, the probe will go back up to its z-high position before traveling to the new position, where it will 
remain at z-high. You may also return the probe to the z-high position without moving in the x or y direction by 

clicking the top up arrow ( ).  You may also raise or lower the probe to any height between z-low and z-high by 
using the up and down buttons. 

In Manual Control mode, you are able to navigate around the plate either by clicking on designated positions 
(wells and rinse stations, recommended) or by using the small and large step arrow buttons to move to a position 
beyond the plate if you need to sample a single tube. 

CAUTION

 

In Manual Control mode, it is possible to move the probe position to any x, y, 
z coordinate, so be aware of where your probe is in the z-axis before moving 
the x or y manually! Do not crash the probe into the side of a well or rinse 
station! 

 
 
When you have completed tasks in Manual Control mode, click Close or click the red X in the upper right hand 
corner of the window. The probe will automatically return to the home position. 
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HyperCyt Options – Deck Configuration 

In order to optimize the proximity of the HyperCyt to your flow cytometer, the HyperCyt can be configured to run 
with the pump on the left or right side of the platform.  In the HyperCyt Controller software under Tools/ 
HyperCyt Options in the Deck section, you can change settings to reflect your particular HyperCyt setup.  You 
can select if the pump is located on the left or the right hand side of the plate deck (this determines the rotation 
direction of the pump head so that fluid flows toward the cytometer).   

You can also indicate whether your system has a shaker by checking the System has a Shaker box (this is selected 
by default).  If you do not indicate that your system has a shaker, shake commands will be eliminated from the 
experiment worklist. 

 
Figure 5-9.  Additional HyperCyt Controller settings. 

 
 
If you have a robotic plate loader, you will select the Enable Automation Interface and the type (TCP/Serial) in 
this window.  Alternatively, if you have a flow cytometer interface, you will select it by checking the box Enable 
Flow Cytometer Integration.  These interface options are discussed in a separate document that is associated with 
the interface product.



62   Chapter 5 Using the HyperCyt Autosampler to Run a Plate 
 

 

 



  
  
  

     63 

Getting Started with HyperView® Analysis 
Software  

The HyperCyt instrument delivers air bubble-separated samples to the flow cytometer in a continuous 
stream and, simultaneously, the flow cytometer continuously collects the data from all wells of the 
microplate, and saves the data in one FCS file.  HyperView Analysis software analyzes this time-
dependent data.  This chapter describes the use of HyperView Analysis software for analyzing the data 
from a sampling run. 

Using HyperView® Analysis Software 

To create an analysis of your experimental data using HyperView Analysis software, begin by opening an 
Experiment (created with HyperView Designer) that has attached FCS data.  Stand-alone FCS files cannot be 
analyzed without the experimental design metadata.  If you have a stand-alone FCS file that you would like to 
analyze, you can create an experiment design to attach it to.   

Two common use-cases have a researcher working with:  

1) The complete HyperCyt System, which includes designing, running and analyzing the experiment on the 
HyperCyt computer. 

2) Offline HyperView Designer and Analysis.  Here the data may have been collected by a different 
researcher, or without the use of the Autosampler, or at a different time. 

If you are working with a full HyperCyt System, and doing data analysis on the HyperCyt computer, the 
process for creating an Analysis with HyperView Analysis is very straightforward.  In this case, you will create 
your experiment design using HyperView Designer, sample it with the HyperCyt Autosampler under the 
control of HyperCyt Controller, attach the collected FCS data using HyperCyt Controller after the run 
completes, then analyze the data for the experiment using HyperView Analysis. 

In the event that you want to analyze an FCS file for which you do not have the HyperView experiment design, 
you must first create an experiment using HyperView Designer (described in Chapter 4) and attach the FCS 
data using that program.  If you are not sure of the precise sampling conditions you can create a design that has 
the correct number of sampled wells designated as Test Sample.  If your sample is from a tube or single well, 
you can create an experiment design that indicates that only one well is sampled. 

 

 

 

Chapter 
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Creating a New Analysis 

Once you have a HyperView experiment design with attached FCS data, you can analyze that experiment 
using the tools of HyperView® Analysis. 

1) On your desktop, double-click on the HyperView® Analysis icon ( ).  

2) To create a new analysis, click the New Analysis button from the toolbar, or select New Analysis from the 
File menu. 

 

Figure 6-1.  Creating a new Analysis. 

3) In the New Analysis window, click the Browse button to find the experiment that you would like to 
analyze.  
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Figure 6-2.  First, Browse to choose the experiment you would like to analyze. 

4) You will see a list of experiments.  Click on an experiment to select it.  Notice that the experiments 
displayed are organized in the same folder system as you set up in HyperView Designer.  Only 
experiments with attached FCS data are shown (they have a green checkmark next to them).  At least one 
plate in the experiment must have attached FCS data before an Analysis can be created for that 
experiment.  Once you have selected the desired experiment, click Open. 

 

Figure 6-3.  Choose an experiment to analyze. 
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5) You will see the New Analysis window, where you may type a name for the new analysis in the Name 
text box, and click Create.  If you do not select a name, the default name of “Analysis” will be used.  You 
can rename the analysis later, if desired. 

 

Figure 6-4.  Naming your new Analysis. 

 

HyperView Analysis Workspace 

In order to make a large amount of data easy to work with, the HyperView® Analysis workspace is divided into 
different areas. 
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Figure 6-5.  Major sections of the HyperView Analysis workspace. 

Main graph and data display:  In this large display area, graphical representations of your data will be 
displayed, including statistics and histograms.  The display will be customized depending on what mode you 
are currently working in. 

Modes/Tasks buttons:  Click on these buttons to choose a different task.  You can work with Compensation, 
Well Identification, Populations, Statistics, and Results (Heat Maps). 

Additional Information display:  Here, you will find additional information, specific to the current working 
mode. 

Plate drop-down menu:  Choose the plate you would like to analyze from the drop-down menu.  This list 
includes all plates in the experiment that have attached FCS data.  In a multiplate experiment, analysis 
progresses independently for the data of each plate. 

The Copy Plate button:  If you have an experiment with multiple plates, the copy plate button, next to the 
plate drop-down menu, allows you to copy all analysis steps performed so far on the current plate to any 
number of other plates.  This can save time if the data of more than one plate will be analyzed in a similar 
fashion.  If the plate you are copying onto already has been analyzed, you will be warned that those analysis 
steps will be overwritten.  You can choose to continue or cancel the copy. 

 

 

An asterisk (*) is displayed in the title bar, next to the Analysis name, if you 
have made changes to the Analysis that have not yet been saved. 
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In the next section, the beginning steps of an analysis are described.  This includes dividing the FCS data into 
those events that correspond to each sampled well, as well as some ways to improve this process.  The next 
two chapters further describe the different steps of working with your analysis. 

Well Identification 

The Well Identification analysis tool displays and finds individual wells in a HyperCyt-produced FCS data file. 
The Well Identification algorithm utilizes experimental parameters such as the sip and up time, multiwell 
shakes and rinse steps, the sampling order, as well as the height of event peaks and the spacing between them 
to segment the data file for the whole plate into individual well data. 

 

To begin, click on the Well Identification mode.   

There are 2 tabs in the Well Identification workspace—Well Finder and Noise Gates.  

Noise Gates (Debris filter) 
Noise gates allow you to create a filter for removing debris or irrelevant events from your analyzed population.  
If you plan to use a noise gate, it is recommended that you do so before doing well identification and creating 
analysis elements that depend on the well populations.  Only the events inside the noise gate will be utilized to 
identify wells.  If you have already done Well Identification, you will have to recalculate the wells after 
creating or editing a noise gate.  To create a noise gate, click the Noise Gates tab.   

 

Figure 6-6.  The Noise Gate view. 

To create a noise gate, use the Add Gate tool.  Click on the Add Gate icon ( ), then click around the area 
you would like to include in your analysis.  Right click to close the gate.  At the bottom of the histogram 
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display, the total number of events, the number of filtered events, and the percent of total events that are 
included in your noise gate are given. 

 

Figure 6-7.  Creating a Noise Gate 

You can edit the noise gate using the Move Gate tool.  Click the Move Gate icon ( ).  Click on a gate 
anchor (a red square located at a vertex) and drag to adjust it.   

You can delete noise gates using the Delete Gate tool.  Click on the Delete Gate icon (  ), and click on the 
name label of the gate you would like to delete. 

   
If you have done Well Identification since your last noise gate change, editing 
a noise gate will require you to recalculate the well populations. 

 

If you would like to set a noise gate based on a different parameter, right click on the axis parameters to get a 
drop-down list of all available parameters.  Click on the desired parameter. 
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Figure 6-8.  Selecting parameters in the Noise Gate view. 

 

You can create as many independent noise gates as you like, including noise gates created using different 
parameter pairs.  If you have multiple noise gates, events are put together with a logical OR to create the 
filtered population. 

   
Noise gates are only used to filter events for Well Identification.  In all other 
population views (Populations, Statistics, and Results/Heat Map), the 
unfiltered data, including all events, will be used. 

If you would like to use the filtered data in these modes, you can select the 
“Apply noise gate to all populations” setting in the Analysis Summary.  See p. 
119  for more details. 

 

Well Finder 
 

Calculating Wells: 

The Well Finder tab displays the data with the number of events graphed versus the elapsed time.  Click the 
Calculate Wells button to automatically divide the data into range gates corresponding with the wells in your 
plate design.  Range gates are outlined in red by default, although this can be changed in the Preferences 
dialog (see Appendix C). 
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If you have a large amount of debris in your specimen you may benefit from 
defining a Noise Gate before identifying wells.  It is recommended that you 
do so before doing Well Identification and creating analysis elements that 
depend on the well populations.  Creating a noise gate invalidates any 
existing well populations, and they will need to be recalculated. 

 

 
Figure 6-9.  Identifying individual well data. 

 
The number of wells identified and the total number of wells in the plate are shown at the top of the histogram.  
The number of wells that are identified will be equal to the number of sample wells on your plate design (these 
are wells of type: Test Sample, Positive Control, Negative Control, Rinse, and Non Test Sample), or less if 
there are errors during well identification.  Identified wells are surrounded with a red range gate.  Each well 
gate is labeled with a unique well ID. 

You can zoom in by pressing the Zoom icon ( ) and clicking and dragging the mouse over the peaks that you 
want to see. UnZoom by right clicking in the Well Identification window and you will see a popup menu. 
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The information grid on the left in the Well Identification pane displays the Well ID, sample type, and the 
number of events in each well.  You can sort these columns, if desired, by clicking on the heading by which 
you want them to be sorted.  

 

Figure 6-10.  Well Identification results information listing. 

 

 

 

 

 

Copy   Copies the image to the clipboard 

Save Image As   Save in a variety of image formats 

Page Setup   Allows you to format the window to print 

Print     Allows you to choose a printer 

Show Point Values Gives the x and y coordinates for the peak  

Un-Zoom  Reverts to the preceding zoom level 

Undo All/Pan  Reverts to the view of the entire plate 

Set Scale to Default Restores the default peak height values 
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Editing wells: 

Occasionally well identification errors will occur.  This can be due to large differences between number of 
cells per well, or broken-up air gaps or samples.  You can pan through the data view to check for well 
identification errors and correct them.  To begin, zoom in to a level at which the individual wells are clearly 
discernable: click the Zoom icon ( ) and select a rectangular region to magnify. 

 

Figure 6-11.  Zoom in to review Well identification Results. 

You can use the Pan Left ( ) and Pan Right ( ) buttons to move through the graph, displaying a peak at 

a time.  To move through the display more quickly, use the Pan Left + ( ) and Pan Right + ( ) buttons. 
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Figure 6-12.  Zoomed in on Wells, using buttons to Pan. 

To add a new well, click the Add Well icon ( ), then click where you would like the new well to be.  This 
adds a range gate that is the average size, but you can change the size later.   

If you have identified more wells than exist in the experiment, one of the rightmost range gates will become a 
temporary well (the range gate label will display “Temporary Well” and a number).  Temporary wells allow 
you to add more wells than are on the plate, to make editing the well identification easier.  These wells are 
temporary because they are not recognized as wells for data analysis.  Only wells that are identified with valid 
Well ID’s can be analyzed.  If you have temporary wells, you should delete wells until the number of identified 
wells matches the number of sampled wells on your plate, before you continue with your analysis. 

To move or resize a well, click the Move Well icon ( ).  If you click on the well’s label, you can drag to 
move the well left or right.  If you click on the left or right boundary of the well, you can drag to resize the 
gatel. 

   
You cannot add or resize well gates so that they overlap.  They are limited in 
size and location by neighboring wells. 

To delete a well gate, click the Delete Well icon ( ).  Then use the cursor to click on the label of the well 
you would like to delete. 



Chapter 6 Getting Started with HyperView Analysis Software  75 

  

Improving Well Identification Results 
 If your data are noisy, the results from automatic well identification may not be satisfactory.  To improve the 
results, you can create a Noise Gate, and repeat the calculation (see p. 68).  Additional utilities can be found in 

the Advanced Settings menu.  Click the Advanced Settings button ( ).  A menu will pop up: 

 

Figure 6-13.  Advanced Well ID settings to improve Well ID results. 

Here, you can choose to filter out events along the base line of your data using Base Event Filtering.  This is 
useful if you have a lot of low-level noise.  Automatic is selected by default.  To choose a value, click to 
deselect Automatic, then select a value from the Base Event Filter drop-down menu.  Any events below this 
value will not be included in the Well Identification calculations.  The new baseline will appear in red.   

You can also choose Smoothing.  This smoothes the data before the well calculations are done.  Click the 
Smooth Factor drop-down menu and select the desired amount of smoothing.  The smoothed peaks will 
appear in green when this is applied. 

After you are done choosing advanced Well ID settings, click Calculate Wells to re-calculate your Well 
Identification.  Or, click Cancel to exit Advanced Settings without saving or applying any changes. 
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Figure 6-14.  Base event filtering and smoothing are applied to improve well identification. 

Exporting All Well FCS data 
Once you have identified wells for your plate, you are allowed the option of exporting the well FCS data.  This 
takes the events of the original FCS file, and divides them into separate FCS files for each well.  You can open 
these files using other FCS data analysis software programs.  Or, you can attach the individual exported well 
FCS file to a new experiment created using HyperView Designer, and analyze it individually using HyperView 
Analysis.  

   
HyperView Analysis also allows you to export well FCS data files for 
individual wells form the Results mode.  For more information, see Chapter 
6, p. 110. 

 

Select Export All Well FCS from the File menu. 
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Figure 6-15.  Exporting Well FCS Data. 

Choose a folder where you would like your FCS data to be placed and click to highlight it.  If you would like to 
create a special folder for the data, click Make New Folder and type a name for that folder.  After you have 
selected the folder, click OK. 

 

Figure 6-16.  Select a folder to save your Well FCS files to. 

Your data files will be placed in a new folder named “<Experiment Name> - <Analysis Name> - <Plate 
Name>”, where <Experiment Name>, <Analysis Name> and <Plate Name> are replaced with the appropriate 
information.  The individual FCS files will be named “Well_A01.fcs”, “Well_A02.fcs”, and so forth. 
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Populations in HyperView® Analysis 
This chapter describes how to continue an analysis by identifying populations of interest utilizing 
relevant fluorescence or light scatter characteristics of the cells or particles being analyzed.   
Populations can be identified utilizing all of the cells within a microplate and the resultant gates and 
regions applied to individual wells.  Control wells within the plate can be combined in order to 
establish the range of data for positive or negative populations.  Additionally, populations can be 
combined in logical gates when required to identify unique subsets of cells or particles within the data 
set. 

 

Using the Data Display Grid and Minimap. 

In the Populations, Results and Compensation Modes, data display utilizes a grid and minimap system to 
simplify the layout of your graphs and results.  When you are working with a large number of graphs, this 
system makes it easy to navigate through them, and to quickly bring up a particular graph. 

 

Figure 7-1.  Working with the Grid and Minimap. 

Chapter 

7 
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When you create a new histogram, heat map, or compensation histogram, a graph will be added to the grid area 
on the right.  In the minimap in the left-hand pane, a small thumbnail will be displayed, representing that graph.  
You can have many graphs open at one time – the current active graph will have a red outline.   

To move the graph, you can click and drag its thumbnail in the minimap area.  Alternatively, you can click its 
border and drag it to a new position in the grid area.  Click on a histogram to select it, then hover over the 

border.  Look for the double-arrow Move cursor ( ), then depress the mouse button and drag the graph to 
the desired location.  Release the mouse button when the graph is positioned correctly. 

To resize a graph, click it to select it.  Then hover over the border that you would like to resize.  Look for the 

double arrow Resize cursor ( ), then click and drag the border to change its size.  Release the mouse button 
when the graph is the correct size. 

Only a portion of the whole grid is displayed in the grid display area.  Right-clicking on a graph in the minimap 
will center the grid display on the chosen graph.  You can also move around the grid by using the horizontal 
and vertical scroll bars.   

You can close a graph by clicking on the “X” in its upper right-hand corner.  Click on the border of a graph and 
drag to re-size that graph. 

Note: closing a histogram, heat map, or compensation histogram does not delete the population, heat map set-
up, or compensation settings.  It simply closes the graph.  Click on the population, heat map, or compensation 
pair to restore the graph. 

 
Figure 7-2.  Enlarging the Minimap. 
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If you would like a larger minimap, you can move the divider above it up, and use the modes/tasks buttons 
divider to shrink those buttons.  The minimap will grow to fit the new space. 

Settings for customizing for the grid and minimap system are in the Preferences menu.  Please see Chapter 9,  
p. 117 for more details. 

Populations 

HyperView analysis allows you to analyze your results by separating events into different populations of 
interest.  This is done by creating range gates and polygonal gates surrounding the desired events in a 1-D or 2-
D histogram view. 

To create or modify populations, click the Populations mode button. 

 

 

A population hierarchy list will be displayed in the left panel, in the Populations tab.   If a plus sign (+) is 
displayed to the left of a population name, you can click it to expand the hierarchy and display all 
subpopulations created from this population.  This allows you to view the populations in an organized manner, 
and displays their relationships logically.  The population hierarchy is described in more detail in Using the 
Population Hierarchy, below.   

To the right, a grid display holds the histograms you have created during your analysis. 
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Figure 7-3.  Working with Populations. 

Creating 2D Histograms 
To create a new 2D histogram click on the population of interest in the Populations list and click the Show 2D 

Histogram Button ( ) and click within the grid display.  Or, right click on the highlighted population 
and select Show 2D Histogram from the drop-down menu.   A 2D histogram will be displayed in the right-
hand data view. 

 

Figure 7-4.   Creating a new 2D histogram. 
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You can change the parameters used in the histogram by right clicking on an axis parameter, then selecting the 
desired new parameter from the drop-down menu. 

 

Figure 7-5.  Changing parameters for a histogram. 

Once you have opened a histogram view, and selected the desired parameters, you can create new populations 
by using the gate tools.   

You can change the input population for an existing population.  This provides an alternative to creating a new 
histogram for each population you would like to view.  It also allows you to re-use the settings you have 
chosen for a particular histogram.  To do so, first click on a histogram to select it, then right click on the 
histogram title.  A drop-down menu will appear, listing the available populations.  Click on the desired 
population.  The histogram will be re-calculated using this population for its input data. 
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Figure 7-6.  Changing the input population for a histogram. 

 

Working with Gates in 2D Histograms 
Working with Polygonal Gates:  Click the Add Gate icon ( ), then click around the population.  Right click 
to close the gate.  Your new gate will be displayed, along with a label indicating the population name.  
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Figure 7-7.  Creating a new Polygonal Gate 

You can rename the population by selecting, then right-clicking on the population in the Populations list.  
Type the new name in the dialog box that appears. 

  

Figure 7-8.  Renaming a population. 

You can edit the gate using the Move Gate tool.  Click the Move Gate icon ( ).  Click on a gate anchor (red 
square located at a vertex) and drag to adjust it.  You can delete gates using the Delete Gate (  ) tool.  Click on 
the icon and then the name of the population.  To adjust the zoom level for a graph, click on the Zoom/Pan       
( ) tool. 
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If you delete a gate that has subpopulations, all subpopulations and other 
populations that depend on that gate will also be deleted. 

 

You can close a histogram by clicking the X in the upper right hand corner when it is displayed.  This simply 
closes the histogram; it does not delete any populations. 

Working with Region Gates:  In 2D histograms, you also have the option of dividing the data into region 
populations.  This creates four quadrants.  After you have created a 2D histogram, click on the region gate tool 

( ).  Use the region gate cursor to click on the desired histogram. 

 

Figure 7-9.  Working with Region Gates. 

You can adjust the center of the region divider to appropriately subdivide the parent population.  Click on the 

move gate tool ( ), then click on the region gate divider. Drag it to the desired location, then release the 
mouse button.  The percentage of events in each quadrant is displayed in the corner of the histogram. 

These populations are added to the populations list with default names.  You can change the Region Set name  
if you would like a name that is customized to your application.  The naming convention is: “Region Set” + a 
number to identify which set + one of four quadrant designations:  LL for the lower-left quadrant, LR for the 
lower-right quadrant, UL for the upper-left quadrant, and UR for the upper-right quadrant. 
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Figure 7-10. Default names for region gates.  This Region set was created from the All Events 
population. 

Creating and Using 1D Histograms 
To create a new 1D histogram, click on the population of interest in the Populations pane.  Then click on the 

1D histogram button ( ) and click in the grid display.  Or right click the population and select Show 1D 
Histogram from the drop-down menu.  A 1D histogram should be created in the right-hand data view. 

 

Figure 7-11.  Creating a 1D histogram. 

 

You can change the parameters used in the histogram by right clicking on the x- axis parameter, then selecting 
the desired new parameter from the drop-down menu. 
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Figure 7-12.  Selecting parameters in a 1D histogram view. 

 

Just as with 2D histograms, you can change the input population for a 1D histogram by first selecting the 
histogram, then right clicking the title.  In the drop-down menu that appears, click on the desired population.  
The histogram will then be recalculated with the new data. 

Once you have opened a histogram view, and selected the desired parameters, you can create new populations 

by using the range gate tool.  Click the Add Gate icon ( ).  Click the left boundary of the population (to the 
left of the desired events), then click the right boundary.  Your new gate will be displayed, along with a label 
indicating the population name. 
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Figure 7-13.  Creating a region gate in a 1D histogram. 

You can edit the gate using the Move Gate tool.  Click the Move Gate icon ( ).  Click on a gate anchor (red 
square located at the edge of the gate) and drag to resize the gate.  Click on the gate’s population label to move 
the gate left or right, or to shift the label up or down.  You can rename the population using the population 
hierarchy (described below).  You can delete gates using the Delete Gate tool.  Click on the Delete Gate icon   

(  ), and click on the gate you would like to delete. 

   
If you delete a gate that has subpopulations, all subpopulations and other 
populations that depend on that gate will also be deleted. 

 

You can close a histogram by clicking the X in the upper right hand corner when it is displayed.  This simply 
closes the histogram, it does not delete any populations or gates. 

Using the Population Hierarchy 
The population hierarchy displays all of your populations in an organized tree structure.  Every time you create 
a gate, you subdivide a population, creating subpopulations.  Subpopulations appear below their parent 
population, on a lower level.  If a plus sign (+) appears next to a population, you can click it to expand a list of 
subpopulations.  If a minus sign (-) appears next to a population, you can click it to collapse (hide) the list of 
subpopulations. 
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Figure 7-14.  The population hierarchy. 

Right clicking a selected population brings up a menu.  This menu includes options for creating histograms, 
deleting the population, and renaming the population.  

Click on a population to select it.  Once a population is selected, you can use the Show 2D Histogram and 
Show 1D Histogram buttons to bring up histograms to display that population.   

To rename a population, right click it and select Rename Population from the drop down menu.  In the 
Rename window, type the new name in the Name text box, then click Save.  You can give populations any 
name so long as it is unique.    

 

 

Figure 7-15.  Renaming populations. 
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Directly below the Populations pane, some statistics are displayed about the currently selected population.  
The parameters used to create the population are given, then the number of events, the percent of total events, 
and the percent of parent population events. 

 

Figure 7-16.  Quick population statistics display. 

If you would like to see the original histogram from which a particular population was created, click on the 
population to select it.  Then right click the population and click Show Gate from the drop-down menu.  This 
will bring up a histogram with the exact display as the one from which you created the population. 

 
Figure 7-17.  Restoring the histogram from which a population was created. 
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Well Populations and Well Type Populations 
After you have used the Well Identification mode to calculate wells, those populations will be displayed in the 
Populations pane under Well Populations.  Individual well populations can be displayed in histograms just 
like other populations, and you are also able to make sub-populations from them (you can create gated 
populations from their histograms).  Click to select the population, then right-click on it.  Choose the histogram 
type you would like from the drop-down menu.  

 

 

Figure 7-18.  Displaying a histogram for the Well A05 population. 

Well Type Populations allow you to analyze Positive and Negative Control populations separately from other 
populations.  This feature is only meaningful if you have designated wells on your plate design as Positive 
Control or Negative Control, and have done Well Identification to assign events to wells.  If you have not 
done these steps the Positive Control and Negative Control populations will be empty.  You can create 
histograms from these populations, but you may not create subpopulations (gated populations of any kind). 
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Figure 7-19.  Working with well type populations. 

 

Logical Populations 
Logical populations offer a powerful way to combine and exclude information from different kinds of defined 
populations.  You can combine Well Populations, Well Type Populations, and populations created from All 
Events. 

To create a logical population, select the populations you would like to include.  Make multiple selections by 
holding down the control key (CTRL) and clicking.  Then right click to open the Boolean Gating Menu.   
Move your mouse over this menu to expand it.  You will be given several possible logical operations: AND, 
OR and NOT.  Click on the desired logical operator.  The NOT operator can only be used between two 
populations (OR and AND can be used between any number of populations), and since the result of the NOT 
operation depends on the order of the operands, you should select populations in the desired order. 
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Figure 7-20.  Creating a logical population using Boolean gating. 

The population will appear under Logical Populations in the hierarchy, with a default name.  If you hover 
over the population with the mouse cursor, the logical expression that created it will be displayed as a tool tip, 
shown below.  It is recommended that you rename these populations to something more informative by right 
clicking and selecting Rename Population. 

 

Figure 7-21.  The logical population created from Population 1 AND A01. 

You can use logical populations to create histograms, just as you would for other types of populations. 

You are not allowed to create subpopulations (gated populations of any kind) from logical populations.  You 
can, however, combine Logical Populations into new Logical Populations.  In this way, you can analyze 
populations using complex and powerful logical statements. 
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Histogram Settings 
In the Histogram Settings tab, there are many options to improve the appearance and clarity of your 
histograms.  You may need to scroll down to see all of the available options.  There are two panels:  Colored 
Populations and Scale. 

 

Figure 7-22.  The Histogram Settings tab. 

 

Colored Populations 

Coloring populations improves the clarity of histogram graphs.  It can also help you identify where a particular 
population appears in a different histogram.  While a histogram is selected, use the Color Button ( ) to turn 
on population coloring for that histogram.  This causes selections you make in the Colored Populations section 
to apply to that histogram. 

To turn on population coloring for a particular population, in the Selected Populations list, check mark the box 
next to the color wheel in the Colored Populations panel, then checkmark next to the population you would like 
to appear colored. 

Note:  You can select which populations have coloring turned on individually for each histogram.  This is 
because you may want to have different populations colored in each histogram, in order to display different 
information. 
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Display order:  you can customize the order in which colored populations display for each histogram.  Since 
some event dots may belong to more than one population, this is useful to choose what color a particular dot 
will appear.  In the Display Order box, click a population, then click the up and down arrows to move it up or 
down in the order.  When you are satisfied with the population order, click Apply to re-color the histogram. 
Populations at the top of the display order will appear at the surface of the screen (these are “on top”).  
Populations at the bottom of the order are on the bottom, and will appear to be layered underneath the other 
populations. 

In the example below, Population 1 and Population 2 are sub-populations of All Events.  If Population 1 and 
Population 2 appear above All Events in the display order they will appear with their own color. 

 

Figure 7-23.  Population 1 and Population 2 appear above All Events in the display order. 

 

If All Events is moved up above Population 2, the Population 2 coloring will be hidden by the All Events 
population coloring. 
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Figure 7-24.  All Events is moved up above Population 2 in the display order. 

 

If All Events is moved to the top of the Display Order, it will hide the coloring for Population 1 and Population 
2. 

 

Figure 7-25.  All Events is moved above Population 1 and Population 2 in the display order. 
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Of course, if the colored populations do not overlap, changing the display order for a histogram will have no 
apparent effect. 

You can change the color associated with a particular population by right-clicking on the population in the 
Population Hierarchy or in the Selected Populations list.  Choose Set Population Color from the drop-down 
menu.  A color chooser will appear.  Click your desired color, then click OK.  The color should update almost 
immediately in the list and in the histograms.  To remove a color associated with a population, uncheck the box 
next to the population and press Apply. 

 

 

Figure 7-26.  Selecting a custom color for a population. 

 

Scale 

In the scale panel, you can adjust the size of histogram dots, as well as the numerical scales on the graph axes.  
To customize the scales for a histogram, first select it in the grid (it should appear with a red border).  Then 
adjust the values of Min X, Max X, Min Y, and Max Y by typing a number or using the up and down buttons.  
Click Apply to allow the settings to take effect.   
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Figure 7-27.  Scale panel options. 

 

Reset Scale:  if you would like to revert to an automatically generated scale click the Auto button.  
Alternatively, you can click the FCS Defaults button to revert to a scale generated from the boundaries of the 
FCS data file. 

Dot Size:  Click on a histogram to select it.  Then select a dot size from the drop-down menu and click Apply.  
Setting the dot size to Medium or Large is useful, for example, to improve visualization of a sparsely populated 
histogram.  The default dot size is Small. 
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Statistical Analysis Using HyperView® Analysis 
HyperView Analysis provides several utilities to facilitate statistical calculations on your data.  
Combined with populations, statistics and heat maps are a powerful means of extracting relevant facts 
from an experiment.  

 

Statistics 

In the statistics mode, you can calculate a number of different statistics for populations that appear in the 
Population Hierarchy.  These can be viewed per population using the Population Statistics tab, and per 
population per well using the Well Statistics tab.  To begin, click the Statistics mode button. 

 

In Statistics mode, a population hierarchy appears to the left, allowing you to select as many or as few 
populations on which to calculate statistics as you desire.  Below that is a grid of checkboxes listed with each 
statistic and each parameter.  To the right are the statistics tabs, where the calculated values are displayed.  You 
can set default statistics in the Preferences menu (see  Ch.9, p117 for more details). 

Selecting Statistics to Calculate 
In the statistics selection grid, checkmark the statistics you would like for each parameter.  If you can’t read the 
entire column label, you can hover over the label with your mouse pointer to display a message with the full 
name of the statistic.  You can select an entire column (calculate that statistic for all parameters) by double 
clicking the column header.  You can select an entire row (calculate all statistics for that parameter) by double 
clicking the row header.  You can un-select entire rows and columns in a similar fashion. 

Select the populations for which you would like to calculate statistics from the hierarchy.  You can choose 
statistics and populations in any order.  Your results will appear almost instantly in the data section, although 
the calculations can take some time for large populations. 
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Figure 8-1.  Calculating population statistics.  The selected statistics will be calculated for All Events and 

Population 1. 

 

Population Statistics 
Once you have selected the populations for which you want to calculate statistics, a short summary of statistics 
will be displayed in the Population Statistics tab for that population. 

 

Figure 8-2.  The Population Statistics display. 

 

Click the plus sign (+) next to the population to expand its full set of statistics calculations.  A grid will appear 
displaying only the statistics you chose from the statistics selection grid. 
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Figure 8-3.  Expanded Population Statistics view. 

 

   
If you change a gate, the statistics are automatically recalculated for that 
population. 

 

Well Statistics 
To view statistics calculations for different populations on a well-by-well basis, click the Well Statistics tab.  
The data are displayed in a tabular form.  Scroll down to view more wells, scroll left and right to view different 
statistics.  Only the statistics you have chosen in the statistics selection grid will be calculated and displayed. 
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Figure 8-4.  The Well Statistics display. 

 

Excel Export 
In both statistics tabs, an Excel Export button appears.  This exports the calculated data shown in that tab to a 
Microsoft Excel spreadsheet format for further analysis.  After you click the Excel Export button, a file 
chooser appears, allowing you to browse to the desired destination folder, and type a name for the exported 
file. 

 

Figure 8-5.  Choose a file name for your exported statistics calculations. 
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Type a name for the file next to File name, then click Save.  Open the file with a spreadsheet program to view 
the statistics and do further calculations. 

 

Figure 8-6.  Excel export of Well Statistics. 

 

Results 

In the Results mode, you can analyze an entire plate of data in a graphical fashion.  This allows you to identify 
wells that are “hits”, and to analyze data in a broader fashion.  Click the Results button to enter Results mode. 

 

The Results mode uses the grid and minimap system to display your heat maps.  Please refer to Chapter 7 p. 78 
if you would like more information on this system.  In the left hand information panel, a listing of the heat 
maps you create will be displayed.  To the right, the heat maps will display in the grid area. 
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Figure 8-7.  The Results mode workspace. 

 

Creating Heat Maps 
Heat Maps are the tool of Results mode.  You can select a parameter of interest, a statistic that you would like 
to compare for that parameter, and the population of interest.  The statistical values are displayed for each well, 
normalized and translated to a color scale. 

   
You must do Well Identification before you can calculate a Heat Map for 
the plate. 

 

To create a Heat Map:  In the left-hand panel, click Add.  This brings up a new heat map with default settings.  
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Figure 8-8.  Creating a Heat Map. 

From the Statistic, Parameter and Population drop-down menus, select the desired parameters you wish to 
display, using the + to expand to select subpopulations if needed.  Then click the Calculate Heat Map button 
to calculate and display the values. 
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Figure 8-9.  The calculated Heat Map. 

You may wish to exclude certain wells from the Heat Map normalization calculation, such as Positive/ 
Negative control wells, or wells that appear to have experimentally insignificant or erroneous values.   

To exclude wells:  first click the wells to select them.  Multiple wells are selected by dragging to select a 
contiguous area, or by pressing the control key (CTRL) and clicking on particular wells to exclude.  After you 
have selected the desired wells, right click and select Exclude from Heat Map from the drop-down menu. 
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Figure 8-10.  Excluding wells from a heat map. 

The results will be automatically recalculated, after excluding the selected wells.  

 

Figure 8-11.  The resulting Heat Map, after excluding column 12 wells. 
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If you decide you would like to include any wells you can similarly select those wells, right click and select 
Include in Heat Map from the drop-down menu.  Those wells will be included in the recalculated heat map. 

You can rename heat maps by right-clicking on them in the list and selecting Rename Heat Map from the 
drop-down menu. 

You can delete heat maps by right-clicking on them in the list and selecting Delete Heat Map from the drop-
down menu. 

 

Figure 8-12.  Adding, renaming and deleting Heat Maps. 

You can close a heat map by clicking the X in the upper right-hand corner when it is displayed.  This closes the 
heat map but does not delete it.  To delete, you must right-click on its name in the list and select Delete Heat 
Map. 

Heat Map Settings 
The settings tab in Results mode provides some utilities that may be useful to your analysis. 

Well Values:  This setting allows you to select whether you would like values displayed on the wells.  You can 
select None to have no value displayed.   If you choose Normalized Values, the normalized value will be 
displayed.  Or, you can choose Actual Value to show the actual value for the selected parameter-statistic on 
each well.  Select the desired heat map, choose an option from the drop-down menu, then click Apply. 
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Figure 8-13.  Displaying actual values for each well in a Heat Map. 

User Defined Range:  This setting allows you to determine how you would like the data to be normalized for 
a heat map.  By default, the lowest value is normalized to 0, and the highest value is normalized to 100.  If you 
set a custom range, the data values will be normalized within the range you select.  The value in the Min box 
will be normalized to 0, and the value in the Max box will be normalized to 100.  Values in between Min and 
Max will be normalized between 0 and 100, and colored accordingly.  Values less than Min will be colored 
blue (minimum color) and values greater than Max will be colored bright pink (maximum color). 

To use this feature, click to select the desired heat map (it will have a red border), then checkmark the box 
labeled Enable.  Then set Min and Max to the desired values by typing a value in the box, or by using the up 
and down arrows.  The software requires that you choose values so that Min is less than Max.  Finally, click 
Apply.  The heat map will immediately be recalculated to reflect the changes. 
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Figure 8-14.  Defining a custom range for normalizing values. 

In this example, the smallest value is 29, and the largest value is 83.  The User Defined range is 40 – 70, so the 
selected parameter (Mean FL1-H) values will be normalized within that range.  Values less than or equal 40 
are normalized to 0 and colored blue, and values greater than or equal to 70 are normalized to 100 and colored 
pink. 

Export Well FCS 
From the Heat Map, you can export an FCS file corresponding to the event data for a particular well (or 
wells).  This is data from the original FCS file, divided according to the Well Identification calculation (see 
Chapter 6, p. 70 for more information about this).  To do so, click the well (or wells) to highlight.  Then right 
click and select Export Well FCS from the popup menu. 
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Figure 8-15.  Exporting FCS data for individual wells. 

You will be allowed to choose which folder you would like the exported file(s) to be placed in.  Choose a 
folder where you would like your FCS data to be placed and click to highlight it.  If you would like to create a 
special folder for the data, click Make New Folder.  After you have selected the folder, click OK. 

 

Figure 8-16.  Select a location to save well FCS data. 
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Your data files will be placed in a new folder named “<Experiment Name> - <Analysis Name> - <Plate 
Name>”, where <Experiment Name>, <Analysis Name> and <Plate Name> are replaced with the appropriate 
information.  The individual FCS files will be named “Well_A01.fcs”, “Well_A02.fcs”, and so forth, using the 
appropriate well identifier for the well, or wells, you selected. 

   
If you would like to batch export all of the well FCS files, click Export in the 
File menu.  Then, choose Export All Well FCS. 
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Advanced Features of HyperView® Analysis 
There are several other powerful features of HyperView Analysis that can enhance the quality your 
data analysis.  Working with these settings, however, may not be necessary for every experiment.  
Compensation settings and advanced preferences settings are discussed in this chapter. 

Compensation 

To improve the quality of your data analysis, HyperView Analysis provides the ability to edit compensation 
settings for your FCS data.  You can adjust compensation for any FCS file, including files which already 
include a compensation matrix and files that have no compensation settings.   

   
If you plan to edit Compensation, it is recommended (but not required) that 
you do so before beginning your analysis.  This is because applying 
compensation to your data may cause the points to move relative to the 
gates you have set, possibly necessitating adjustments to those gates. 

 

To enter Compensation mode, click the Compensation button. 

 

The grid and minimap visualization scheme is used in the Compensation mode.  For more information on this 
scheme, see Chapter 7, p. 78.  In this mode, values are displayed as parameter pairs in the left-hand information 
pane.  In the right-hand grid display area, 2D histograms show the effects of any Compensation you have 
applied.  Below the histogram, both compensation pairs appear, allowing you to edit the compensation amount. 
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Figure 9-1.  The Compensation workspace. 

Enabling and Disabling Compensation 
The Enable Compensation check mark at the bottom of the left-hand panel gives you the ability to enable 
(checked) or disable (unchecked) compensation.  When compensation is enabled, all changes are immediately 
applied to all data in the analysis.  When it is disabled, all compensation will be removed (set to 0%) from the 
data in the analysis.   While compensation is disabled, you can add compensation pairs to the list, but the 
calculations will not be immediately applied to the data.  Removing the compensation will not change the 
original metadata collected with the FCS file, but will be saved with the Analysis file. 

Adding Compensation 
Click the Add button to add a new compensation pair.  Choose which parameters you would like to edit from 
the drop down menus, then click OK.  You will be able to edit both compensations for this pair at the same 
time (Param 1 - % Param 2 and Param 2 - % Param1). 
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Figure 9-2.   Creating a new compensation setting. 

A 2D histogram will be created using the selected parameters.  If you do not like the default data display, you 

can use the Switch Axes button ( ) in the upper left-hand corner to switch which parameter is displayed on 
which axis.  Below the histogram, both compensation pairs are shown.  You can edit the percent subtracted by 
typing in the value box, or by clicking the up and down arrows.  You are allowed to enter a value between 0 
and 1000 %.  Click Apply to apply your changes.  The histogram will show the effect of the new 
compensation setting on the data.  The edited compensation pair should now appear in the listing on the left-
hand side of the screen.  If you have not selected Enable Compensation, you will not be able to see your 
changes immediately, but they will be added to the list of compensation pairs. 

 

 

Figure 9-3.  Compensation applied to the FL1-H/FL2-H parameter pair. 
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Editing Compensation 
In the compensation grid, the current compensation settings are displayed (Minus %).  In addition, the original 
value of the compensation is also shown (Original %).  If your FCS file came with compensation settings, this 
value is the value from the FCS file.  Otherwise, if you created the compensation pair, the original value is 
shown as 0%. 

 

Figure 9-4.  Compensation listing including applied and original values. 

 

You can edit compensation that you have created, as well as the compensation that was applied in the file.   To 
do so, highlight the compensation pair you would like to edit by clicking on it, then click the Show button.  
The 2D histogram for that pair should be shown to the right.  You can type in the text box to change the 
percentage values.  Click Apply to apply the new setting.  The change will appear in the grid under the Minus 
% column.  If compensation is enabled, your change will also be shown in the histogram view. 

If you type a value in the percentage box, but decide that you do not want to alter the compensation, you can 
click the Cancel button.  The compensation value will return to the most recent previously applied value. 

To delete a compensation pair, highlight it in the grid, then click the Delete button.  You cannot delete a 
compensation pair that was loaded from the FCS file.  If you would like to eliminate these compensation 
settings, you can set them to 0%.   

 
Closing a histogram does not delete compensation settings. 

 

To bring up a particular compensation histogram, highlight the desired parameter pair in the list, then click 
Show.   If the histogram exists in the grid, the view will move so that it is centered in the display area.  If the 
histogram does not exist, a new one will be created and added to the grid. 
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Preferences Settings in HyperView Analysis 

The Preferences window in HyperView Analysis allows you to customize several features of the program, if 
desired.  You can customize what statistics are displayed by default, how numbers are displayed, how 
histograms are displayed, grid display settings, and how well FCS data files are exported.  To open the 
window, click Preferences under the File menu. 

 

Figure 9-5.  Preferences settings for HyperView Analysis. 

Default Statistics for New Analyses:  Use this setting if you are only interested in certain kinds of statistics.  
Click the box next to a statistic to select it.  When you create a new analysis, these statistics will already be 
selected, and you will only need to choose the population for which to calculate statistics. 

Numeric Formatting:  These changes apply immediately to the current Analysis.  If you check mark “Show 
thousands separators”, a comma will separate thousands in calculated numeric values for easier reading.  You 
can change how many decimal places are displayed for calculated values and percentages by clicking the up 
and down arrows next to each setting. 

Histograms:  These settings apply immediately to the current Analysis, and affect how histograms are 
displayed.  The 2D histogram bin threshold setting allows you to set the minimum number of events in a bin 
before it will be displayed in a 2D histogram.  This can make the histograms easier to read because they are 
less crowded.  However, if you are looking at single well data, you may want to set the bin threshold lower. 

If you like, you can change the default colors for the 1D histogram borders and fill to make them easier to see.  
Click on the colored circle, and a color chooser will appear from which you can select your preferred color.   
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Layout:  These settings apply immediately to the current Analysis and allow you to change how you work 
with the data display grid.  “Snap to Grid” allows you to choose if you would like to be able to place 
histograms at any location in the grid area (unchecked), or if you would like them to snap in place along the 
grid lines (checked).  Check “Show Grid” or “Show Minimap” to use the grid or minimap.  Uncheck these if 
you would prefer not to work with these features.  Set the “Grid Increment” to the desired size in pixels to 
customize how often grid lines occur.  Click the circle next to “Grid line color” to change the color of grid lines 
using a color chooser dialog. 

 

FCS Data:   

 Include HyperCyt settings in exported Well FCS files.  This includes information about 
how your plate was sampled using the HyperCyt Controller software in any exported well 
FCS files.  It adds the information from the settings you selected in HyperView Designer 
under the Sample Settings tab to the exported FCS file. 

 Include well contents in exported Well FCS files.  This includes the content information for 
the well when well FCS files are exported.  This is the content information that you may have 
added at the experiment design step using HyperView Designer. 

 Include compensation overrides in exported well FCS files.  If additional compensation 
has been applied to the FCS file in the course of creating an Analysis in HyperView Analysis, 
you can export the additional compensation matrix information in well FCS files using this 
setting.  Currently, this only applies to Analyses created with Diva 6.0 FCS files. 

 

View Menu Options 

The View menu provides another way to switch between analysis modes.  Click on a mode name to go to that 
mode.  In addition, the View menu provides access to two summaries, the Analysis Summary and Plate 
Summary, which give additional information about your analysis and experiment. 
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Figure 9-6.  The View menu. 

 

Plate Summary 
The plate summary lists the FCS header information for the current Plate’s FCS file. 

 

 
Figure 9-7.  The plate summary includes information from the FCS file header. 

 
 

Analysis Summary 
The Analysis Summary summarizes basic information about your Experiment and Analysis.  You can view the 
Experiment Name and Analysis Name.  You can view a list of all plates in the experiment, and note which 
ones have FCS data attached (this is in contrast to the Plate Switcher, which only displays plates that have 

attached FCS data).  Plates with attached FCS data have a green check mark icon ( ). 
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Figure 9-8.  The Analysis Summary gives information about your experiment. 

 
 
In the Analysis Summary, you can also type a note describing your analysis or providing additional 
information.  This note will be saved along with the Analysis. 

Apply Noise Gate to All Populations:  Normally, when you create a noise gate, it is only used to eliminate 
noise for Well Identification.  If you would like to eliminate noise in all populations in the analysis, select the 
“Apply Noise Gate to All Populations” option. If this option is selected, the “All Events” population will be the 
same as the noise gated population.  This setting applies to all plates in an analysis. 

Saving and Exiting 

To save your analysis click Save Analysis in the File menu.  You will know you have changes on the analysis 
that have not yet been saved, as an asterisk (*) will appear in the title bar next to the Analysis (Experiment) 
name. 

Choose Save Analysis As from the File menu to make an exact copy of your analysis.  If you have unsaved 
changes, you will lose those in the original, but they will appear in the new copy.  You will be asked for a 
name for the new analysis.  Type the name then click the Save button. 
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Figure 9-9.  Create a duplicate of your analysis using the Save As feature. 

 

After you have saved, click the red X in the upper right-hand corner to exit the program.
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Configuring Your HyperCyt® Using IntelliCyt 
Manager 
 

The IntelliCyt Manager is configured during HyperCyt installation.  It is organized into 5 areas under 
individual tabs. 

 Settings:  manages global system settings and storage preference for nightly database backups.  

 Licensing:  manages the access to each software program and number of active users per application 
as well as the flow cytometer automation clients. 

 Users:  manages users’ access to the software. 

 User Groups:  allows the administrator to group user privileges by different tasks.  

 Connections:  allows the administrator to view and kill application connections. 

  Flow Cytometers:  allows you to add flow cytometers if you have an IntelliCyt Data Manager 
system server. 

 HyperCyts:  allows you to manage multiple HyperCyts if you have an IntelliCyt Data Manager 
system server. 

Only one instance of the HyperCyt Manager can be run at any given time; attempting to run more than one 
instance will result in “Unable to connect to the HyperCyt data store. All licenses for IntelliCyt Manager are 
currently in use.” IntelliCyt Manager reports the status of its connection to the HyperCyt database in the status 
bar located in the bottom left portion of the window. 

File  Exit  Exits the application. 

Help  About Displays the HyperCyt Manager About dialog box. 

Settings Tab 
 

Appendix 

A 
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Figure A-1.  General settings in IntelliCyt Manager 

General Settings: 

 
Include [ # ] entries in the Recent Experiments list. 

 
A global setting (all users) that controls the number of recent experiments to display in HyperCyt 
Designer and Controller. The default value is five recent experiments. 

[ ] Restrict experiment visibility to team members only. 

The default is for this checkbox to be off and to allow any user to see all the experiments in the 
system. If this checkbox is checked, the users can only see experiments that they have created or have 
access to as a team member. 

[ ] Allow automatic creation of user accounts at first login. 

If this checkbox is checked, when a new user runs any HyperCyt application for the first time, they 
will be prompted for a display name and an account will be created for them based on their Windows 
login information. If this checkbox is not checked, the user must be manually added in the Users tab of 
the HyperCyt Manager. 

Default user group for new users. [name] 

This allows you to select what privileges new users will automatically have.  You can choose any user 
group that has already been created (see the User Groups tab). 
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Maximum  number of files in FCS cache. [#] 

The FCS cache holds the most recently used FCS files locally in order to improve access times.  You 
can change the number of files held in the cache. 

Nightly Backup Settings: 

 [ ] Enable night backup. 

If this checkbox is checked, the HyperCyt System will automatically backup the HyperCyt database 
each day to the local server. 

Run backup [ # ] hours after midnight. 

This setting is used to specify the time to run the nightly backup. The default value is 1 hour after 
midnight to run the nightly backup. 

Retain backup files for [ # ] days. 

This setting determines how long to keep a nightly HyperCyt database backup; the default is to keep a 
database backup for fifteen days. 

Copy backup files to [_______

This setting allows for the nightly HyperCyt database backup file to also be copied to another 
computer on the network for greater backup safety. The default path is empty, which will not copy the 
nightly HyperCyt database backup file to another machine. To enable this additional backup, click 
Browse and locate the appropriate storage location. 

name_______] Browse 

Save Settings – Save any changes made to the Settings Tab. 

Cancel Settings – Cancel any changes made to the Settings Tab. 

 

If you do not click Save or Cancel Settings and attempt to click on another tab, a dialog will pop up to remind 
you to save or cancel. 

 

Figure A-2.  Save changes in each tab before continuing. 
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Licensing Tab 
The Licensing tab displays the current licensed information for the HyperCyt Server. It includes information 
on license status, number of licensed connections per application, and optional licensed features. 

 

Figure A-3.  Viewing license information in the Licensing Tab. 

Clicking the Update License button allows the system administrator to capture a unique license seed that is 
tied to their HyperCyt Server to send to IntelliCyt for purchasing license upgrades.  Click Copy to Clipboard 
then paste the seed into an email to IntelliCyt Support. Your IntelliCyt Support representative will email you 
back your new license file. Save this file on your HyperCyt Computer in a safe location. 
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Figure A-4.  The Update License Wizard guides you through the process of adding a license. 

After the new license file has been generated by IntelliCyt, the second step of the wizard allows the system 
administrator to import the license by clicking Import License File… and locating the license file you saved 
from your email.  Click Finish to update the license.  If the license file is invalid, contains an error, or has been 
altered, the software will display the error message “Unable to apply license. Invalid License.”. 

 

Figure A-5.  Finalize your new license.  You will be notified if the license information you provided 
has been applied, or if it is invalid. 
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Users Tab 
The Users tab allows you to view and edit all active and inactive users. The default setting shows all the active 
users for this HyperCyt System including the Display Name used by HyperCyt and Windows username used 
for Windows Authentication. Clicking on the Inactive radio button will display all the previous users no longer 
permitted to login into the HyperCyt system.  For Windows systems using Domain Authentication, you will 
see Domain Name\Username in the Logon field.  

 

Figure A-6.   Use the Users Tab to manage logon information for users. 

Clicking the Add button brings up the Add User dialog box to create a new user account. The first field is for 
the Display Name, used by the HyperCyt System, and the second field is for the Windows username.  You can 
select a user group for this user from the Group drop-down menu. 

 

Figure A-7.  Adding a new user to the HyperCyt system. 
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Clicking to highlight a user from the list, then clicking the Edit button brings up the Edit User dialog box, 
which allows the system administrator to change the User’s display name, their Logon Name, or their User 
Group.  The system administrator can also uncheck the Active checkbox to make the user inactive and 
disallow that user from logging in to the HyperCyt system.  

 

Figure A-8.  Editing user logon information. 

The Delete button is only enabled for users that have not yet created an experiment or been assigned to an 
experiment. Deleting a user is a permanent operation and is most often used when a user is created with the 
wrong display name or logon Windows username. 

In some cases you may not want to use Windows Authentication.  If so, choose Manual from the 
Authentication Mode menu.  This allows you to directly control the way that user accounts are created and 
validated for the HyperCyt system, separately from the Windows login system. 

User Groups Tab 
The user groups tab allows you to group permissions for different types of users.  You can select from the three 
default user groups (Administrators, Hardware Managers, and Users), or create your own.  You can also edit 
existing user groups, with the exception of the Administrators group.  You can assign Users to User Groups in 
the Users tab (see above). 
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Figure A-9.  Define user groups with different permissions in the User Groups Tab. 

Click the Add button to add a new custom user group.  Type a name for the group in the Name box, and select 
which permissions you would like users in this group to have by check marking the box next to it in the Assign 
Permissions area.  Click Save to create the new group. 

 

Figure A-10.  Defining a new user group. 

You can view, or change the permissions for a particular user group by highlighting its name in the grid under 
Group Name, then clicking Edit.  Permissions that are allowed for this group will have a check mark next to 
them.  To turn a permission on or off, check or uncheck the box next to it.  Click Save to apply your changes. 
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Figure A-11.  Changing the settings for a user group. 

To delete a user group, highlight its name in the grid, and click Delete. 

   
You may not Edit or Delete the Administrators group. 

 

Connections Tab 
The Connections tab displays all the applications that are connected to the HyperCyt system.  Clicking 
the Refresh button will update the list of applications that are connected to the HyperCyt system.  
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Figure A-12.  Use the Connections Tab to monitor the IntelliCyt software that is currently in use. 

 

Flow Cytometers Tab 
The Flow Cytometers tab allows the system administrator to manage HyperCyt Flow Cytometer 
Automation clients for the system. The HyperCyt Flow Cytometer Automation client is used to automate 
control of the Flow Cytometer data acquisition software, and is an optional feature for your HyperCyt 
System.  
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Figure A-13.  Manage flow cytometer automation clients using the Flow Cytometers Tab. 

 

Clicking the Add button allows the system administrator to add a new HyperCyt Flow Cytometer 
Automation client to the HyperCyt system.  This new automation client will then be available for 
selection by HyperCyt Controller.  

 

Figure A-14.  Adding information for a new flow cytometer automation client. 

The Alias field is the name that will be displayed in the HyperCyt Flow Cytometer Automation client list 
in a HyperCyt Controller application. The Hostname/IP Address field is used for locating the HyperCyt 
Flow Cytometer Automation client, typically this is either the hostname resolved by DNS or the 
machine’s IP address. The user can click the Test button to verify that an operational Automation client 
could be found at the specified hostname / IP address.  Invalid or non-operational HyperCyt Flow 
Cytometer Automation client configurations cannot be saved.  

Clicking the Edit button allows the system administrator to update either the Alias field or the hostname 
/ IP address field.  

 

Figure A-15.  Edit flow cytometer automation client information. 

Clicking the Delete button allows the system administrator to delete the HyperCyt Flow Cytometer 
Automation client from the HyperCyt System. 
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HyperCyts Tab 
 

 
Figure A-16.  Manage multiple HyperCyt Autosamplers in the HyperCyts Tab. 

 
If your laboratory has multiple HyperCyts, you can manage them under the HyperCyts tab.  This is useful if 
you have more than one HyperCyt Autosampler connected to an IntelliCyt Data Manager server.  When the 
HyperCyt Controller software is started, it will display which HyperCyt Autosampler it is connected to in the 
lower-left-hand status bar. 

 

Figure A-17.  The status bar in HyperCyt Controller indicates which HyperCyt Autosampler is 
currently connected. 

To add a new HyperCyt to your system, click Add.  You can enter a descriptive Name for the instrument, a 
Device ID, and a Serial Number.  The Device ID field must be completed for each new HyperCyt installed; 
this allows the software to identify and communicate with the correct instrument.  Device IDs range from 10 to 
19, and must be unique.  Entering a Serial Number is optional and is provided as a convenience to the user, to 
assist with identifying the device.  Click Save to finish adding the new HyperCyt. 
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Figure A-18.  Identifying a new HyperCyt Autosampler. 

You can also edit existing HyperCyts.  Click the Edit button.  You can change the Name, Device ID, and 
Serial Number.  You can also set a HyperCyt as Inactive by unchecking the box next to “Active”, if it should 
not be used at this time.  Inactive HyperCyts cannot be accessed by HyperCyt Controller.  You can set a 
HyperCyt to be Active by check marking the box, making it available for use. 

 

 
Figure A-19.  Update the settings for a HyperCyt Autosampler. 

 
If you will no longer use a configured HyperCyt device, you may choose to permanently delete it.  To do so, 
select its entry in the list, and click the Delete button.  In many cases, particularly if you may use it again, 
setting such a device to Inactive is adequate. 
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User Tips 
This appendix provides a variety of useful tips for the use of the HyperCyt system. If you have a 
technical question that you are unable to answer after consulting the documentation, contact 
technical support. 

 

Sample Carryover 
Carryover can be attributed to two sources in sampling from microplates.  One factor is the carryover on the 
outside of the sample probe.  This is minimal in sampling small volumes where the outside of the probe is 
inserted into a small volume of sample suspension.  However, if sampling deep wells, carryover on the 
outside of the probe may need to be removed by a wash step.  The other factor in carryover is concerned 
with the concentration of sample.  If the sample concentration in one well is considerably higher than the 
following well, the percent of carryover can be a concern.  Determining the optimal concentration per well 
for your specimen and having a consistent concentration per well will minimize the issue of carryover.  It is 
important that each experimental system be optimized in order to provide reliable data.  If your experiment 
involves measuring rare events, it is critical that thorough washing between samples is performed.  The 
HyperCyt has the ability to perform several washes to prevent carryover of rare events.   

IntelliCyt researchers have found that at least 0.1% bovine serum albumin (or some other equivalent 
protein) should be used in all solutions to help minimize particle carryover. You can expect 1-2% particle 
carryover in a no-wash format. This carry-over can be reduced to less than 1% after one wash. However, for 
every experimental system, it is advisable to verify the effects of your buffer and adjust if necessary. 

Do not substitute any other type of tubing for the recommended PVC tubing. All other tubing types suitable 
for peristaltic pumping that we have tested are conducive to high levels of carryover. 

Be sure to minimize any dead volume in the junction where the PVC sample tubing adjoins the flow 
cytometer sample uptake tube. This junction is a potential particle trap that can lead to significant increases 
in carryover, and is where most carryover problems originate. IntelliCyt recommends slipping the PVC 
tubing directly over the sample uptake tube.  

Use an awl to expand the tubing prior to inserting the sample probe. 

Further, any additional tubing junctions you introduce in the sample line are likely to cause increased 
carryover. 
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Instrument Setup 
IntelliCyt researchers routinely run the pump at 15 rpm. This is approximately 100-120ul/minute of sample 
being introduced into a flow cytometer with sheath pressures around 5psi, like the Cyan or LSRII.  Flow 
cytometers with higher or lower sheath pressure may require higher or lower flow rates.  As in your flow 
cytometer, increasing the sample pressure, or increasing the pump speed will increase the sample core and 
decrease resolution.  Conversely, decreasing the pump speed will make the sample core smaller and thus 
increase the resolution.  

Another critical control is the adjustment screw which controls the amount of pressure on the peristaltic 
tubing on the pump head. When adjusted properly, you should be getting uniform air bubbles on both sides 
of the pump. If the bubbles are broken up on the flow cytometer side of the pump, you probably have over-
tightened the clamp. Finding the right tension initially may take time and patience. Once set, clamping 
pressure typically remains stable over the course of a day without requiring operator intervention. 

 

Data Resolution 
To optimally resolve clusters of events you need to acquire with a time resolution of 100 ms. If you are 
utilizing an older flow cytometer you may need to adjust this to allow for sampling an entire plate.   

For example, with the BD FACSCalibur: The time parameter in CellQuest™ is 10 bits—which means that 
you are only allowed 1024 time channels for a single data acquisition session; when you reach the 1024th 
channel, data acquisition automatically stops and the data file is stored. At 100-ms resolution you can only 
acquire data for a total of 102.4 seconds. Using a 200-ms resolution time channel with BD CellQuest 
(suboptimal but workable) which allows a 204.8-second acquisition time, a little more than is required for a 
96-well plate at 40 samples/minute. Another option is to sample a partial plate, save the data and sample the 
remaining portion of the plate and save as a separate file. 

Newer flow cytometers have much higher resolution and can collect data from a 384 well plate with no 
issues of time resolution. 

Clogging 
Flow cytometry is a technology that is dependent on single cell suspensions.  Live cells can often become 
problematic and form clumps during analysis which clog the flow cell.  This is still a valid concern in 
HyperCyt flow cytometry.  Priming the tubing prior to the run with an appropriate buffer and running a 
clean cycle with detergent and D.I. water in rinse stations S3 and S4, respectively, will minimize clogging 
problems from the HyperCyt side. Releasing the Compression Cam at the end of each day is also critical to 
maintaining the sample tubing.  If you have a particularly “sticky” cell type you can consider intra-well 
rinses, between-plate cleaning cycles, or including a reagent that inhibits clumping in your buffer solution.  
Including a protein source in your sample wells (e.g., serum, 0.1%BSA, etc.) minimizes clogging in the 
sample tubing as well as particle carryover.  
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Always have a spare tubing set available that has been tested for proper operation. Use this to quickly 
determine if any problem is due to a defect or an obstruction in the tubing pathway.
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Additional User Information 
This appendix provides a variety of additional user information for the use of the HyperCyt® 
System. Many of these features are not essential for daily use, but may be handy to some individual 
users. If you have a technical question that you are unable to answer after consulting the 
documentation, contact technical support. 

 

Importing and Exporting an Experiment in HyperView Designer 

The software is designed to optimally be used with a database on a IntelliCyt Data Manager server, but it 
can also function as a stand-alone system.  If you are using it as a stand-alone, without the database, you can 
create experiments offline and use them on the HyperCyt Sysstem by importing and exporting.  Exported 
experiments can be shared between different researchers and different HyperCyt Systems.  To export an 
experimental design, first open the experiment using HyperView Designer.  Then, click on File /Export. 

 

Figure C-1.  Exporting an experiment design. 
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Choose Experiment from the drop-down menu.  A dialog box will allow you to choose the desired export 
folder.  Then, type in the name you have given to the experiment in File Name field.  Exported files are 
given the extension .iex for IntelliCyt ex

Click Save in the dialog box.  If your experiment has attached FCS data, you will be given the option of 
exporting the experiment design only, or the experiment design and the attached FCS.   

periment. 

 If you are duplicating an experiment to run on the HyperCyt you will choose not to include FCS 
data in the exported .iex file 

 If you are exporting an experiment to analyze on another computer select to include FCS data in 
the exported experiment.  The FCS data will be attached when the .iex file is imported and a green 
check mark will appear next to the experiment in the Plates list.  You can immediately continue 
working with the experiment, including analyzing data using HyperView Analysis. 

To open experiments that were previously exported as .iex files, go to the File menu and click Import 
Experiment. 

 
 

 
 

Figure C-2.  Importing an experiment design. 
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A dialog box is displayed allowing you to navigate through your folders and choose the name of the file 
you want to import.  The file name will end in the extension .iex.   

   
Using HyperView Designer to import .iex files, only experiment design and 
FCS data will be imported.  If you want to import a complete .iex experiment, 
including the full analysis, use HyperView Analysis to import. 

 

 

 
 

Figure C-3.  Choosing an experiment to import. 
 
 

Highlight the desired file and click Open in the dialog box.  Your experiment will open.  This creates a new 
experiment with the settings you exported.  The new experiment will have the same name as the original 
experiment, unless that name has already been used in the system that imports the experiment.  In that case, 
an underscore, ‘_’, and a number will be appended to create a unique name.  This name can be changed to 
something more meaningful if desired by using Rename Experiment in the File menu. 

 

Importing and Exporting Analyses using HyperView Analysis 

In addition to sharing experiment designs, you may wish to share your data analysis.  You can do this by 
exporting the Analysis using the HyperView Analysis software.  Such an export will contain all of the 
information for the experiment:  the experiment design, the FCS data, and the data analysis. 
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Figure C-4.  Exporting an analysis. 

In the File menu, select Export, then Analysis.  A dialog will come up allowing you to browse to a location 
for the exported file will be stored.  Then, type a name for the file next to File name and click Save.  An 
.iex file will be created containing your exported analysis.  

 

Figure C-5.  Choosing a file name for an exported analysis. 

To import an analysis file, select Import from the File menu, then choose Analysis.  You will be able to 
browse for your .iex export.  Select the desired file and click Open.  A new experiment will be created that 
contains the experiment design, attached FCS data, and the analysis that was exported.   
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Figure C-6.  Importing an analysis. 

The newly created experiment and analysis will have the same names as the original, unless that experiment 
name has already been used in the current system.  In that case, the newly created experiment will have an 
underscore, ‘_’ and a number appended.  This temporary name can be changed, if desired, using Rename 
Experiment from the File menu of HyperView Designer. 

   
If you select an .iex file to import that does not contain an analysis, you will 
get an error message, stating that the Analysis could not be created.  In this 
case, the experiment design will be created, and any FCS data will be 
attached, but no Analysis will be created. 

 

Import and Export CSV Plate Designs Using HyperView Designer 

HyperView Designer allows you to export your experiment designs to CSV (comma-separated variable) 
format.  You can load these files into a spreadsheet or text editor program, add annotations, and import 
them into a new experiment design.  This is another way to create a template for your experiment designs, 
in addition to using the Save As feature.  Unlike the Save As feature, the exported design will only include 
the plate designs and not the sampling and experiment information found under the Experiment Setup and 
Sample Settings tabs.   

CSV export also provides a way to annotate well types and contents that may be convenient for some users. 
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Figure C-7.  Exporting a plate design to CSV format. 

To create a CSV export of your experiment design, select Export from the File menu, then choose Plates 
to CSV.   
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Figure C-8.  Choosing a file name for the exported CSV file. 

You will get a dialog allowing you to select the name and location of the file.  Browse to the folder where 
you would like the file to be located, and type a filename next to File name.  Click Save to create the export 
file.  You can then open the CSV file in a spreadsheet program.  You may need to indicate that the text is 
comma-delimited. 

 

Figure C-9.  The exported CSV file. 
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You can make annotations to this file that will appear on the experiment once it is imported into HyperView  
Designer.  You can change the well type, as long as you change it to one of the valid well type names.  You 
can also add contents and annotations (usually concentration values) to the wells.  Add contents and 
annotations in pairs, starting with the column after the well types.   You may add as many contents as you 
like to as many or a few wells as you choose.  If you do not want to add an annotation to the content, be sure 
to leave a blank column before moving to the next column to add the next content - see Content 2 in figure 
C-10, below. 

 

Figure C-10.  Annotating an exported CSV file. 

To import the experiment design from a CSV file, you first need to create a new experiment to import the 
design into.  Be sure that the plate style has the same number of wells as does your CSV file.  If the 
experiment has any well type or content assignments, these will be overwritten by the imported design. 
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Figure C-11.  The results of importing a CSV experiment design. 

   

If you are working with a multiplate experiment design, information from all 
plates will be included in one file.  Each plate will be separated by its Plate 
Number (plate name). 

 

Attaching and Clearing FCS Data Using HyperView Designer and 
HyperCyt Controller 

During normal usage, you will attach FCS data to your experiment directly after you have run sampled it 
using HyperCyt Controller and the HyperCyt Autosampler.  In some cases, you will want to attach and 
clear data at a different time, for example if you accidentally chose the wrong FCS file.  Both HyperCyt 
Controller and HyperView Designer have the ability to attach and clear FCS data. 

To attach FCS data to your experiment, select Attach FCS Data from the File menu.  You will get a dialog 
box that allows you to browse for your desired FCS file.  Click on the file; then click Open.  FCS data will 
be attached to the current plate, so be sure that the correct plate is selected before opening the Attach FCS 
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dialog.  If you attempt to Attach FCS Data to a plate that already has attached FCS data, you will get a 
warning indicating that the original FCS Data will be overwritten. 

   

If you have already created an analysis for the Experiment using HyperView 
Analysis, it is recommended that you do not change the FCS file.  Changing 
the FCS file could invalidate your data.   If you find it necessary to change the 
FCS data of an Experiment that has already been analyzed, you should 
delete any Analyses first. 

 

While the FCS file is being uploaded, a progress message will be displayed. A green check mark ( ) 
indicates that the file has been attached successfully.  

This icon will appear in HyperCyt Controller in the Plate Navigation strip.   

 

Figure C-12.  A green checkmark indicates Plate 0001 has attached FCS data. 

It will appear in HyperView Designer next to the plate in the Plates list.   
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Figure C-13.  A green checkmark indicates Plate 0001 has attached FCS data. 

This icon will also appear in the file chooser when you attempt to open an experiment in either program.  In 
a multiplate experiment, you will see the icon if at least one plate has attached FCS data.  Experiments with 
no attached FCS data will have a NEW icon next to them. 

 

Figure C-14.  A green checkmark indicates experiment_96well has attached FCS data. 

To clear FCS data, select Clear FCS Data from the File menu.  This will clear FCS data associated with 
the current plate.  The green check mark should no longer be displayed in the Plate lists and Experiment list. 



  Appendix C Additional User Information  149 

  

 

 

Figure C-15.  Clearing FCS data from the current plate. 

   

If you have already created an Analysis for the experiment using HyperView 
Analysis, you will need to delete the Analysis before you will be allowed to 
clear the FCS data. 

 

Exporting FCS Data using HyperView Designer and HyperView 
Analysis 

The original FCS data files that are attached to your experiment or analysis can be exported using either 
HyperView Designer or HyperView Analysis. 

The process is the same in both cases: 

Select File, then Export from the drop-down menu, then FCS Data.   
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Figure C-16.  Exporting FCS data attached to Plate 0001. 

You can browse to choose a directory for the exported data to be located.  If you click the Make a New 
Folder button, you will get a new folder in the currently selected directory, which you can name to help you 
identify the exported file.  This can be useful if you are doing multiple FCS exports. 
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Figure C-17.  Choosing a directory to export FCS file into. 

If your experiment contains composite FCS data, that is, more than one FCS file makes up the data for a 
single plate, you have the option of stitching that data into a single FCS file, or exporting the original files.  
If you export a stitched file, the file will be named your plate name with “.stitched.fcs” as the file name 
extension.  If you export the original files, a folder will be created that contains the FCS files.  This folder 
will be named your plate name, with “_FCS” appended. 

 

Figure C-18.  Options for exported FCS files. 

If you have a multiplate experiment, the FCS file exported will be the one attached to the currently selected 
plate. 

   

HyperView Analysis also allows you to export FCS files created from the 
data identified for each well (Well FCS).  This feature is discussed in more 
detail in Chapter 8. 

 



152   Appendix C Additional User Information 
 

 

Changing Default Colors in HyperView Designer 

You are able to change the default colors for well assignments in HyperView Designer if a given user has 
difficulty seeing some colors or simply has a personal preference. Any changes made to the Well 
Assignment colors will remain associated with the individual copy of Designer on that location (computer) 
and any Experiments opened on that location will display that color scheme.  

Click Tools in the menu bar which will release a drop down menu. 

Click Customize Well Colors. 

 
Figure C-19.  Choosing custom well colors. 

 
A Customize Well Colors dialog box will appear.  Under the Color header, click on the colored circle that 
you want to change. 

 

Figure C-20.  Choose a well type to change its color. 
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A Select Color dialog box appears.  Click on a section of the multicolor circle that you want to 
change to.  Or you can change the color by adjusting the hue, saturation, brightness, and red, green, 
and blue scales below the circle.  

 

 
Figure C-21.  Picking a color. 

 
Click OK.  The Select Color dialog box disappears. 

You can choose another Well Type to change colors, following the previous 3 steps. 

Click Save on the Customize Well Colors dialog box. 

The new color of the Sample Category should now appear in the top menu. 

 

Managing Experiments in HyperView Designer 

The software suite gives you the flexibility of organizing your experiments and analyses at any stage in the 
data collection and analysis process.   

Organizing Experiments 
You can organize experiments using HyperView Designer.  This can make it easier to find a particular 
experiment.  You may wish to organize them by date, by researcher, by research project or some other way.  
To begin, in the File menu, click Manage Experiments.   
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Figure C-22.  Organizing experiments using Manage Experiments. 

Click the New Folder button to create a new folder in the Projects pane.  The new folder will be placed 
hierarchically below the currently selected folder.  You can rename the folders by clicking to select them, 
then single clicking.  You will get a cursor allowing you to rename.  To put the experiments in the folders, 
simply drag them from the Experiments pane, and drop once you reach the desired folder.  You can view 
which experiments are in a particular folder by clicking on that folder.  You can view all experiments by 
clicking All Experiments in the Projects pane. 

Renaming Experiments 
To rename an experiment, select the experiment from the Experiments Pane by clicking on it.  Then click 
the Rename button.  If the experiment that you would like to rename is open, you must choose Rename 
Experiment from the File menu. 

 
Figure C-23.  Renaming an experiment. 

 
Type the name into the New Name box and click OK to apply the change. 
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Deleting Experiments 
To delete an experiment, select the experiment from the Experiments pane by clicking on it.  Then click the 
Delete button.  If the experiment that you would like to delete is open, you must choose Delete 
Experiment from the File menu.  You will see a dialog confirming that you want to delete the experiment.  
Click OK. 

If the experiment you would like to delete has attached FCS data or any analyses, you will be warned that 
these items will be deleted along with your experiment design, and asked if you would like to continue. 

 

Figure C-24.  Attempting to delete an experiment with attached FCS data and associated analyses. 

Remember, you can delete analyses without deleting the experiment design.  This is described in the next 
section.  Clearing FCS data from an experiment was described in a previous section. 

Managing Analyses in HyperView Analysis 

You can manage the Analyses you have created for an Experiment using HyperView Analysis.  Click on 
the File menu, then click Manage Analyses.   

Analyses are organized by the Experiment that they apply to.  To find a desired analysis click the Browse 
button. 
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Figure C-25.  Choose an experiment to manage its Analyses. 

 

Then select the experiment and click the Open button.  Analyses for that experiment will be listed in the 
Manage Analyses window. 

 

Figure C-26.  Managing Analyses. 
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Renaming Analyses 
To rename an Analysis, click to select it, then click Rename.  If the Analysis you would like to rename is 
currently open, you will need to select Rename Analysis from the File menu. 

 

Figure C-27.  Renaming an Analysis. 

Type the new name for the Analysis, then click OK. 

Deleting Analyses 
To delete an Analysis, click to select it, then click Delete.  If the Analysis you would like to delete is 
currently open, you will need to select Delete Analysis from the File menu.  You will be asked if you are 
sure you want to delete the analysis.  Click OK. 
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Troubleshooting 
This section provides answers to system troubleshooting questions that you may have when operating the 
HyperCyt® System. If you have a technical question that you are unable to answer after consulting the 
documentation, contact Beckman Coulter technical support. 

 

 

Before you contact us, it is helpful if you are prepared to answer the following questions: 

 What were you doing when the problem occurred? 

 Can you reproduce the problem? 

 Did you try to solve the problem? If so, what steps did you take and what did you observe? 

 Which error messages, if any, did you see? 

Having these answers will help us provide you with a solution as quickly as possible. 

Powering the System 

Why isn’t the HyperCyt System powering up? 

Verify the following: 

 All system components (Autosampler and Peristaltic Pump) are plugged into their power 
sources. 

 Fuses are not blown. Consult the 223 Sample Handler Users Guide or the Peristaltic Pump 
Users Guide for details on how to change fuses. 

Autosampler Control 

Why is the Autosampler Control window not controlling the Autosampler? 

 Check that the cable on the back of the Autosampler is connected to the HyperCyt 
computer. If your computer does not have a serial port and utilizes a Keyspan Serial to 
USB connector, check that connection as well.  In particular, be aware that the connection 
to the HyperCyt computer USB port can easily slip out if the computer or the cable is 
moved. 
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Keyspan connection-- Serial-Serial:Serial:USB 

 

Why is the Autosampler Status Light Off or Blinking? 

The Autosampler Status Light indicates the status of the system. The following table gives the 
meaning of indicator lights and outlines any actions that you should take. 

Autosampler Troubleshooting (Status Light Indicator) 

Status Light Description and Required Action 
Off If the Status Light is off: 

- Make sure power is turned on 
- Check AC power cord and connections 
- Try a different AC outlet 
- Check fuse(s) and replace if necessary 
- Check all Autosampler connections 

Blinking  If the Status Light is blinking: 
- Check for obstructions to horizontal or 

vertical arms or probe 
- Turn Autosampler off and then on 
- Restart Sample Handler software 
- Check for error code from Sample Handler 

software 
 

 

 
Computer 

Serial Cable 
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Fluidic Sample Delivery Troubleshooting Guidelines 

This section offers a number of points to consider if you are having difficulty getting a sample 
properly delivered from the microplate to the flow cytometer. 

Important points: 

  

 
Sample Probe is in center of well. 

 
 

  

 
The Sample Probe should not touch the bottom of the well. 

 
 

  

 
Do not over-tighten the probe retaining screw such that it can crimp the 
Sample Probe. 

 
 

  

 
Use the Tubing Expander Tool to enlarge the Sample Line Tubing before 
inserting the Sample Probe. Be careful not to puncture the Sample Line 
Tubing. 

Do not use the Sample Probe itself to insert new Sample Line Tubing. 

 

  

 
A bent or crimped Sample Probe can result in decreased sample pick-up. 

 
 

 

 
If the Sample Line Tubing is slipping off of the flow cytometer sip tube, it 
could mean that there is a clog in the sip tube.  Alternatively, the tubing 
connection could be cracked or split. 

 
 

  

 
 If the sample profile looks like the number of events are decreasing across 
the plate, check the Sample Probe position at the bottom of the microplate 
well. Some microplates are not always even and you may need to adjust 
the Z-low position of the Sample Probe. 
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If the Sample Line Tubing is making a loop on the incoming side of the 
Peristaltic Pump pump rollers, check to see that the Sample Line Tubing is 
seated properly around the rollers.  

 

 

  

 
Broken air bubbles before the pump usually indicate a clogged Sample 
Probe, and after the Peristaltic Pump a clogged Sample Line Tubing. 
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Interpreting Flow Cytometry Results in Troubleshooting Fluidic 
Sample Delivery  

In this section, we show some common problems and suggestions by interpreting the data output 
from the flow cytometer. 

 

 
 

 

 

 

 

 

 

 

 

Note spacing between blocked controls

Decreased volume in the rinse station
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If there is a large volume of sample in the well, sample on the outside of the probe could be 

 run down the probe and be intermixed with the air bubbles as mini slugs. 

 
 

 

Example of clogged probe 

 

uneven pick-up, usually due to clogged probe and/or worn tubing

Uneven air bubbles and fluid slugs caused by:
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Large air bubbles – either probe is clogged or not positioned
correctly causing compression at the end  

Loss of the last blocked control consequence of decreased 
rinse volume

Even slugs and air bubbles 
result in this type of profile
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